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Trademarks 
Unigraf, UCD, UCD-323 Gen2, UCD-323, UCD-301, UCD Console and TSI are trademarks of 

Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo, and HDMI 

Port Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the 

United States and other countries. 

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or 

other countries. 

Windows® 11 and  Windows® 10 are trademarks of Microsoft Corporation. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf or 

its authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or replace, 

and replacement product may be new or reconditioned. Replacement product shall be of 

equivalent or better specifications, relative to the defective product, but need not to be identical. 

Any product or part repaired by Unigraf pursuant to this warranty shall have a warranty period of 

not less than 90 days, from the date of such repair, irrespective of any earlier expiration of original 

warranty period. When Unigraf provides replacement, then the defective product becomes the 

property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-300 family products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 

  



  About This Manual 

 

UCD-3XX User Manual • UCD Console 3.9 4. 

Table of Contents 

 
Copyright ........................................................................................ 2 
Notice .............................................................................................. 2 
Company Information ...................................................................... 2 
Edition ............................................................................................. 2 
Trademarks ..................................................................................... 3 
Limited Warranty ............................................................................. 3 
CE Mark .......................................................................................... 3 
Table of Contents ............................................................................ 4 

 About This Manual ........................................................................................... 7 
Purpose ........................................................................................... 7 
Product and Software Version ........................................................ 7 
Notes ............................................................................................... 7 

 Introduction ...................................................................................................... 8 
Product Description ........................................................................ 8 
UCD-301 ......................................................................................... 8 
UCD-323 and UCD-323 Gen2 ....................................................... 10 
  Safety and Operational Precautions ........................................ 11 
Compliance Information ................................................................ 12 
End-of-life Handling ....................................................................... 14 

 Installation ...................................................................................................... 16 
Installation Package ...................................................................... 16 
Software Installation ...................................................................... 16 
Firmware Update Procedure ......................................................... 18 
Firmware Downgrading ................................................................. 23 
Device Roles ................................................................................. 24 
Change Device Configuration ....................................................... 25 

License Manager ..................................................................................... 26 
UCD Console .......................................................................................... 28 

Device Selection ........................................................................... 28 
Analyzer and Generator Operation ............................................... 28 
UCD Console Menu ...................................................................... 29 
Detaching and Cloning Tabs ......................................................... 32 

 Analyzer Operation ........................................................................................ 33 
Functionality Tabs ......................................................................... 33 

Standard Tabs ......................................................................................... 34 
Video Tab ...................................................................................... 34 
Capture Tab .................................................................................. 38 
Audio Tab ...................................................................................... 39 
EDID Tab ....................................................................................... 41 
HDCP Tab ..................................................................................... 42 
Source DUT Testing Tab ............................................................... 43 

DP Reference Sink .................................................................................. 45 
DP Link Tab .................................................................................. 45 
DPCD Tab ..................................................................................... 49 
SDP Tab ........................................................................................ 50 
AUX Controller Tab ....................................................................... 53 

HDMI Reference Sink .............................................................................. 55 
HDMI Link Tab .............................................................................. 55 
InfoFrames Tab ............................................................................. 58 
CEC Tab ....................................................................................... 59 
eARC Tx (enhanced Audio Return Channel Transmitter) .............. 63 

 Generator Operation ...................................................................................... 65 
Functionality Tabs ......................................................................... 65 

Standard Tabs ......................................................................................... 66 
Pattern Generator Tab .................................................................. 66 
Playback Tab ................................................................................ 71 
Audio Generator Tab..................................................................... 86 



  About This Manual 

 

UCD-3XX User Manual • UCD Console 3.9 5. 

HDCP Tab ..................................................................................... 87 
EDID Tab ....................................................................................... 88 
Sink DUT Testing Tab ................................................................... 89 

DP  Reference Source............................................................................. 91 
DP Link Tab .................................................................................. 91 
DPCD Tab ..................................................................................... 96 
MST – 2 Streams .......................................................................... 97 

HDMI Reference Source ......................................................................... 98 
HDMI Link Tab .............................................................................. 98 
SCDC Monitor ............................................................................. 100 
CEC Tab ..................................................................................... 100 

 UCD Timeline viewer ................................................................................... 102 
 Event Log ..................................................................................................... 106 

Logged Events ............................................................................ 107 
Event Transaction List ................................................................. 109 
Customizing Transaction List ...................................................... 110 
Parsed Transactions ................................................................... 112 

 EDID Editor .................................................................................................. 114 
Controls ...................................................................................... 114 
EDID Editor Features ................................................................... 115 
Editing Tips ................................................................................. 115 

 Packet Editor ................................................................................................ 117 
Introduction ................................................................................. 117 

 Pattern Editor ............................................................................................... 118 
Introduction ................................................................................. 118 

 Image Converter .......................................................................................... 120 
Appendix A: Product Specification................................................................................ 121 

UCD-301 ..................................................................................... 121 
UCD-323 ..................................................................................... 121 
UCD-323 Gen2 ........................................................................... 122 

Appendix B: Product Features ...................................................................................... 123 
UCD-301, UCD-323 & UCD-323 Gen2 ........................................ 123 
UCD-301, UCD-323 & UCD-323 Gen2 (cont.) ............................. 124 

Appendix C: Predefined Timings .................................................................................. 126 
Appendix D: Predefined Patterns .................................................................................. 132 

Fixed Patterns ............................................................................. 132 
Extended Patterns ....................................................................... 133 
Extended Patterns (contd.) .......................................................... 134 
Extended Patterns (contd.) .......................................................... 135 
Extended Patterns (contd.) .......................................................... 136 

Appendix E: Sink and Source DUT Tests ...................................................................... 137 
Test Report ................................................................................. 138 
Audio Test Set – DP Rx, HDMI Rx ............................................... 139 
CEC Functional Test Set – HDMI Rx ........................................... 140 
CRC Video Tests – HDMI Rx, DP Rx............................................ 141 
Timings Video Tests – HDMI Rx .................................................. 144 
Electrical Test Set – HDMI Rx ...................................................... 145 
Electrical Test Set – DP Rx .......................................................... 147 
Link Config Tests – DP Rx ........................................................... 149 
Pixel Level Video Tests – DP Rx, HDMI Rx .................................. 150 
VRR Source DUT Tests – HDMI Rx ............................................. 151 
VRR Sink DUT Tests – HDMI Tx .................................................. 152 

Appendix F: Vpattern Language ................................................................................... 153 
General ....................................................................................... 153 
Commands .................................................................................. 154 
Variables ..................................................................................... 160 

Appendix H: Playlists and Scenarios ............................................................................. 162 



  About This Manual 

 

UCD-3XX User Manual • UCD Console 3.9 6. 

Playlists ................................................................................................. 163 
Scenarios .............................................................................................. 164 

Parameters .................................................................................. 164 
Example ...................................................................................... 167 

Sample Content in Playback Tab .......................................................... 169 
HDMI ........................................................................................... 169 
DP ............................................................................................... 170 
Playlist: Basic Video & Audio Example ........................................ 171 
Playlist: Audio-Video Latency ...................................................... 172 
Playlist: HDR & Metadata Example .............................................. 173 
Playlist: Grayscale ....................................................................... 174 
Playlist: Dolby Vision DEMO (HDMI) ............................................ 175 
Playlist: VRR Example (HDMI) ..................................................... 176 
Playlist: QMS-VRR Example (HDMI) ............................................ 177 
Playlist: ALLM (HDMI) ................................................................. 178 
Playlist: HDR10+ SSTM & SBTM Example (HDMI) ...................... 179 
Playlist: HDR10+ SSTM Example (DP) ........................................ 181 
Playlist: Frame Rate Example (DP) .............................................. 182 
Playlist: PSR1 (DP) ...................................................................... 183 
Version History ............................................................................ 184 

 

 

  



  About This Manual 

 

UCD-3XX User Manual • UCD Console 3.9 7. 

 ABOUT THIS MANUAL 

Purpose 
This guide is User Manual of UCD-301, UCD-323 and UCD-323 Gen2, USB-connected video 

interface test units for use with a PC with Windows® 11,  Windows® 10 or Windows® 8 operating 

system. 

The purpose of this guide is to 

• Provide an overview of the products and their features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of the units. 

• Provide instructions for the user on how to use UCD Console software. 

 

Product and Software Version 
This manual explains features found in UCD Console Software Bundle 3.5. Please consult Unigraf 

for differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and 

FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is 

formatted as follows. Please read these notes carefully. 

Note: This text is an important note 

 

 

Note: This version of the User Manual describes features in UCD Console software version 2 based on 

the functionality in Microsoft Windows operating system. 

 

UCD Console is available also for macOS operating system to be used in iMac and MacBook 

computers and for Linux operating system.  

 

Detailed description of the macOS and Linux versions will be added later. 
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 INTRODUCTION 

Product Description 
UCD-300 family are high speed, USB 3.0 connected video interface test unit. UCD-300 series 

consists of the following units: 

UCD-301 DisplayPort 1.4 and HDMI 2.0 analyzer 

UCD-323 HDMI 2.0 and DisplayPort 1.4a (limited to HBR2) video generator and 

analyzer for Dolby and HDR10+ testing 

UCD-323 Gen2 HDMI 2.0 and DisplayPort 1.4a (limited to HBR2) video generator and 

analyzer. UCD-323 Gen2 is a companion tool for PHY test equipment to 

perform automated DP 2.0 PHY compliance testing for Source and Sink 

DUTs. 

 

UCD Console is user interface (GUI) for UCD family test equipment for desktop use. The outlook 

and details of UCD Console will vary depending on the capabilities of the connected unit and will 

reflect the features enabled.  

Unigraf UCD units feature a high-level Software Development Kit (SDK) called Test Software 

Interface (TSI) for use in automated testing. TSI allows for an easy integration of Production and 

R&D testing routines into an automated test system environment. Please refer to TSI 

documentation found in additional Unigraf manuals for more details. 

UCD-301 

Product Features 

• UHD / 4K@60Hz compliant video analyzer for testing DisplayPort™ and HDMI Sources.  

• Enables testing all aspects of HDMI 2.0 and DP 1.4a with HBR2 max bit rate capability. 

• High resolution video and audio capture up to up to 4K / UHD 60 Hz 

• Compatible with HDCP versions 1.3 / 1.4 and 2.2 / 2.3 

• 2 GB on-board high-speed video buffer 

• High speed USB 3.0 host PC interface 

Functional Description 

UCD-301 units consist of a multimedia signal input stage, a control stage with on-board frame 

buffer and a PC interface stage. In the Input Stage the signal is conditioned and converted to 

desired format. The Interface and Control stages are either passing the captured data directly to 

the USB interface or storing it to the frame buffer. Interface & Control stages are receiving 

instructions from the host PC to configure and control the functionality of the unit. 

Please find below logical diagram of UCD-301 unit 

UCD-301 

Control & 

Interface 
USB 3.0 

Host PC 

DP Input DP 

HDMI Input HDMI 

Electrical 

Testing 

On-board 

Frame Grabber 
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Delivery Content 

UCD-301 product shipment contains: 

• The UCD-301unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output), System input: 12Vdc, 

3A 

• USB 3.0 compliant cable  

 Connections 

The image below indicates the connections in UCD-301 unit and their description 

Name Description 

DP In DisplayPort 1.4 compliant input from the upstream Source 

HDMI In HDMI 2.0 compliant input from the upstream Source 

S/PDIF In Test input for ARC Function  

Power In +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 

 



  Introduction 

 

UCD-3XX User Manual • UCD Console 3.9 10. 

UCD-323 and UCD-323 Gen2 

Product Features 

• UHD / 4K@60Hz compliant video generator and analyzer for testing DisplayPort™ and HDMI 

sinks and sources.  

• Enables testing all aspects of HDMI 2.0 and DP 1.4a with HBR2 max bit rate capability. 

• High resolution video and audio capture an generation up to up to 4K / UHD 60 Hz 

• Compatible with HDCP versions 1.3 / 1.4 and 2.2 / 2.3 

• 4 GB on-board video buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

UCD-323 units consist of a multimedia signal input stage, an internal pattern generator, a control 

stage with on-board frame buffer and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format.  

The Interface and Control stages are either passing the captured data directly to the USB interface 

or storing it to the frame buffer.  

The internal pattern generator is able to source a signal for testing sink and branch units. The 

Interface & Control stages are receiving instructions from the host PC to configure and control 

the functionality of the unit. 

UCD-323 Gen2 • AUX Controller for PHY CTS 

UCD-323 Gen2 is a companion tool for PHY test equipment to perform automated DP 2.0 PHY 

compliance testing for Source and Sink DUT. AUX controller is supported using Unigraf TSI API. 

Please find below logical diagram of UCD-323 unit 

Delivery Content 

UCD-323 product shipment contains: 

• The UCD-323 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output), System input: 12Vdc, 

3A 

• USB 3.0 compliant cable  

  

UCD-323 

Control & Interface 
USB 3.0 

Host PC 
DP In / Out DP 

HDMI In / Out HDMI 

Internal 

Pattern Generator 

On-board 

Frame Grabber 
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Connections 

The image below indicates the connections in UCD-323 unit and their description 

Name Description 

DP in DisplayPort™ 1.4 compliant input from the upstream Source 

DP out DisplayPort™ 1.4 compliant output to the downstream Sink 

HDMI in HDMI 2.0 compliant input from the upstream Source 

HDMI out HDMI 2.0 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

USB USB 3.0 connection to the host PC 

  Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions 

and Warnings. 

• The product is intended to be supplied by an IEC/EN 61010-1 or IEC/EN 62368-1 certified 

adapter or DC power source, suitable for operation at a minimum ambient temperature of 

40°C, providing an output that meets PS2 (or LPS) requirements, rated at 12 V DC, 3A, with 

a compatible mating connector. 

 

Note: UCD-300 devices are IEC certified. Please use them only with the power adapter 

provided in the box; do not use third-party or external power sources. Unigraf does not 

authorize the use of non-original power components. Please ensure that the connectors and 

cabling to the power adapter are intact. If there are any doubts regarding the condition of 

the adapter or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 

240 Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not 

connect the device. 

• UCD devices are rated for indoor use only. They are rated for Pollution Degree 2 as defined 

in IEC 61010-1. This classification corresponds to usage in a typical office or home 

environment. Under normal use, only dry, non-conductive pollution occurs. Occasionally, 

temporary conductivity caused by condensation can be expected. Temporary condensation 

occurs only when the product is out of service. 

• Maximum Operating Altitude: 2000m 

• To ensure compliance with all applicable EMC standards, use high-quality shielded interface 

cables. The clamp-on ferrite supplied with the product must be installed on the USB cable. 
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• When installing the unit, connect the Power Adapter to the UCD device first, after that 

connect the AC plug. Please disconnect the USB cable to the controlling PC and remove 

cabling to DUT while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without written permission from 

Unigraf. Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes 

is forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please 

ensure that the PC used for controlling the UCD device complies with the minimum 

requirement set by Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download 

page (https://www.unigraf.fi/downloads/). Please update the device firmware to match the 

installed software. 

 

Compliance Information 
This section lists all the applicable Safety, Electromagnetic Compatibility (EMC), and 

Environmental standards with which the instrument complies as well as the end-of-life handling 

requirements for proper disposal of the instrument. This product is intended for use by 

professionals and trained personnel only; it is not designed for use in households or by children.  

The following certifications and compliance markings are applicable to the product. 

 

CE Certification   

 

 

CE marking is a certification mark that indicates conformity with health, safety, and environmental 

protection standards for products sold within the European Economic Area. 

 
The product meets intent of the European Council Directives 2014/35/EU for Product Safety, 

2014/30/EU for Electromagnetic Compatibility (EMC) and 2011/65/EU for Restriction of 

Hazardous Substances (RoHS).  Compliance was demonstrated to the following specifications as 

listed in the Official Journal of the European Communities:  

 

Safety Compliance 

• EN 61010-1:2010+A1:2019 Safety requirements for electrical equipment for measurement, 

control and laboratory use. 

• EN IEC 61010-2-030:2021 Particular requirements for testing and measuring circuits. 

EMC Compliance1 

 

• EN IEC 61326-1:2021 EMC requirements for electrical equipment for measurement, control, 

and laboratory use. 

• EN IEC 61326-2-1:2021 Particular requirements for sensitive test and measurement 

equipment for EMC unprotected applications. 

1  This product is intended for use in nonresidential areas only.  Use in residential areas may 

cause electromagnetic interference.  To ensure compliance with all applicable EMC standards, 

use high-quality shielded interface cables. The clamp-on ferrite supplied with the product must 

be installed on the USB cable.  
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RoHS Compliance 

• EN 63000:2018 Technical documentation for the assessment of electrical and electronic 

products with respect to the restriction of hazardous substances 

Unless otherwise specified, all the materials and processes are compliant with the Restriction of 

Hazardous Substances (RoHS) Directive 2011/65/EU in its entirety, inclusive of any further 

amendments or modifications of said Directive.   
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End-of-life Handling 
 

WEEE Certification   

 

 

WEEE marking indicating separate collection for WEEE- Waste of electrical and electronic 

equipment. The instrument is marked with this symbol to indicate that it complies with the 

applicable European Union requirements of Directives 2012/19/EU and 2006/66/EC on Waste 

Electrical and Electronic Equipment (WEEE) and Batteries. 

 
 

CHINA RoHS Certification    

 

 

China RoHS 10 marking is a certification mark that indicates conformity with the Chinese 

government regulation to control the restriction of hazardous substances for products shipped to 

China. 

 
Unless otherwise specified, all the materials and processes are compliant with the latest 

requirements of China RoHS 2.  The hazardous substances contained in the instrument are 

disclosed in accordance with the standards SJ/T 11364-2014 (Marking for the restricted use of 

hazardous substances in electronic and electrical products) and GB/T 26572-2011 (Requirements 

on concentration limits for certain restricted substances in electrical and electronic products). The 

instrument is marked with an appropriate Environment Friendly Use Period (EFUP) symbol.   
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中國 RoHS  

The information in the following table is applicable for products manufactured on or after January 

1, 2015 for sale in the People’s Republic of China. 

产品中有害物质的名称及含量 

 

 

 

 

 

 

 

 

 

 

 

注： 本表依据 SJ/T 11364 的规定编制。  

O：表示该有害物质在该部件所有均质材料中的含量均 在 GB/T 26572 标准规定的限量要求以。  

X：表示该有害物质至少在该部件的某一均质材料中的 含量超出 GB/T 26572 标准规定的限量要

求。 

-：表示该项为排除项目。 

标记 “X”的部件，皆因全球技术发展水平限制而无法实现 有害物质的替代。印刷电路板组件包括

印刷电路板 （PCB）及其组件、集成电路（IC）和连接器。某些 型号的产品可能不包含上表中的

某些部件，请以实际购 买机型为准。 

部件 

名称 

鉛 

(Pb) 

汞 

(Hg) 

鎘 

(Cd) 

六價鉻 

(Cr(VI)) 

多溴联苯 

(PBB) 

多溴二苯醚

(PBDE) 

風扇組件 O - O O O O 

軟排線 O - O O - - 

印刷電路板

組件 

O - O O - - 

連接器組件 O X O - O O 

导电布 O - O - O O 

银色焊锡 O - O - - - 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows and 

macOS. 

The installation package is a bundle between the components needed for UCD Console SW and 

for TSI SDK. The bundle contains the following items: 

• Windows/macOS drivers (installed during set up)  

• UCD Console SW (installed during set up) 

• License Manager (installed during set up) 

• Device configuration utility (installed during set up) 

• Packet Editor (installed during set up) 

• TSI SDK 

• User Manuals including this document.  

• In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact 

Unigraf. 

Note: The software should be installed before connecting the UCD unit to the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 

Windows 

 Install *.exe file from the package.  

 Start installation by running application SoftwareBundle_X.X.XXXX. 

The welcome page is displayed and shows the software package release version. 

The user is also asked if he/she wants to: 

• Create a desktop shortcut 

• Install the Visual C++ redistributable (needs to be present on Windows) 

• Install Unigraf USB drivers 

 Confirm by selecting Next dialog button. Select Install to start the installation. 

 Select Finish to exit the installation dialog. 

 

macOS 

 Install *.pkg file from the package. This is a universal binary for ARM and Intel x86. 

 Start installation by running application SoftwareBundle_X.X.XXXX. 

 Confirm by selecting Next dialog button. Select Install to start the installation. 

 Select Finish to exit the installation dialog. 

Note: If you are downgrading, please remove the Unigraf UCD Tools folder from the Applications 

folder before starting installation. 

Note: If installation fails, remove the Unigraf UCD Tools folder and any possible copies from the 

Applications directory and try again. 

 

https://www.unigraf.fi/downloads/
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Linux 

 Linux extract the *.tar.gz file. You will find two install scripts (install-libfuse.sh and install.sh). 

 In the Files app select each script in turn, right click and select Properties to open the 

Properties dialog. Toggle the Executable as Program button. 

 In the Files app open a terminal window by unselecting any selected files and right clicking 

and selecting  Open in Terminal to run the scripts (order is important). 

 In the terminal type:  sudo ./install-libfuse.sh 

 You will be prompted for you password.   

 Type: sudo ./install.sh  

 You will be prompted with: 

Please proceed to 'Software & updates' application to tab 'Other Software' and uncheck 

checkboxes or remove 'cdrom' entry from /etc/apt/sources.list file. Otherwise you will have 

problems during UCD Console package installation. If you are already done, enter the key 

'y'. If not - 'n' 

 For Ubuntu just enter y. For debian follow instruction. 

 You will then be prompted again with: 

Please proceed to 'Software & updates' application to the first tab and set check box 

'Officially supported (main)'. Otherwise you will have problems during UCD Console 

package installation. If you are already done, enter the key 'y'. If not - 'n' 

 For Ubuntu just enter y. For debian follow instruction 

 Answer y for additional prompts. 

 The Ucd Tool Installer Setup app should now be running. 

 Select Next> 

 Select radio button for Install for all users or Install just for me. 

 You are asked to Choose Installation Directory. Do NOT choose the default 

(/root/Unigraf/Unigraf UCD Tools at time of writing). Select a directory that is easy to access 

and remember. 

Note the warning: Installing in existing directory. It will be wiped on uninstallation. 

 Select Next> Install and Finnish. 

 Navigate to the Unigraf UCD Tools directory under the installation directory and double 

click the app you want to run (UCDConsole.AppImage for example). 
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Firmware Update Procedure 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A 

firmware set for the selected operation roles is created and the firmware set is programmed to 

the device. Please contact Unigraf for details. 

Updating from Earlier FW Versions 

UCD Firmware versions prior to 1.8.52 (see Help > About on Consol) do not support the procedure 

described here. Follow the instructions in Appendix G Firmware Recovery Procedure with Quartus 

Prime in this manual. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do 

not power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-4XX device, perform the following 

steps: 

 Connect the UCD unit to a power supply and connect the USB cable. 

 Open UCD Console SW. Select Tools > Firmware Update. UCD Config will open. 

UCD Config 

The first page of the utility indicates the firmware component versions present in the package. 

Select Enable advanced mode checkbox if you want to customize the installation (possibly to 

downgrade firmware for example).. 

Select Next to proceed. 
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UCD Device Selection 

From the list of connected UCD devices please select the one that you want to update. Click 

Next. 

 

Review updates 

A new dialog lists: 

 FW components available in the UCD device 

 Current FW version (from) 

 FW to be installed (to) 

 

Note: Selecting individual components for update is only enabled in Advanced Mode. 

Click Start to start the FW update procedure. 

 

 

. 
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Advanced Mode 

Advanced mode allows users to select individual components to update. Click Next to review the 

components and start the update procedure. 
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UCD Device roles 

Select the available roles for your UCD-3XX device. Click Next to proceed. For detailed 

explanation of the device roles, please refer to the next chapter on this manual. 

 

Configuration in progress 
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During the installation, you will be prompted to power cycle the device (power off, wait for 10 

seconds and then power the device on again). Select OK to proceed. 

 

After the update has finished, click Next to see a summary and select Finish to complete. 

Please note that the update proceedure may take several minutes to complete. 

Recovering Failures in FW Update Procedure 

If FW Update procedure fails (e.g., when updating from an earlier FW that does not support the 

procedure described here) refer to Appendix G of this manual for instructions in Firmware 

Recovery Procedure with Quartus Prime.  

Once FW Recovery procedure has been done and a Firmware version supporting UCD Firmware 

Configuration tool has been installed, all future updates can be done using this tool.  
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Firmware Downgrading 
The previously released Unigraf SW Bundle 2.4.XX package does not contain UCD Device 

Firmware (FW). In case UCD device has been installed with the FW delivered with Unigraf 3.X SW 

Bundle, and version downgrade is needed, also UCD Device Firmware has to be rolled back.  

Please follow the procedure below: 

1. Download the latest Console 2 SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_2.4.XX.exe in the package to install the package. 

Please do not launch UCD Console application yet. 

3. Download Console 2: FW Package 2.3.38 from the same download page 

4. Run the application FirmwarePackage_2.3.38.exe to copy UCD device FW in a proper 

folder in your PC 

5. Launch UCD Console 

6. Select Tools > Firmware Update to start UCD Config utility 

7. In UCD Config select Enable advanced mode 

8. Select the device. Click Next. 

9. In UCD Modules select the module titled MC3XX F.X.X.X/N.X.X.X 

10. Click Next. Click Start to start programming FW to the connected UCD Device 
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Device Roles 
The use of UCD-3XX devices with UCD Console is divided in interface specific roles. The structure 

of UCD Console varies between roles by having a varying set of tabs dedicated to functionalities 

available in the selected role. The table below lists the roles and tabs available in each role. Please 

find a detailed description of each role in the later chapters of this manual. Please find a 

description on changing device configuration later in this document. 

Available Roles UCD-301 

• DisplayPort Reference Sink (SST, HDCP 2.3) 

• HDMI Reference Sink (HDCP 2.3) 

• HDMI, DisplayPort (SST). SPDIF Reference Sink 

o Enables SPDIF audio testing 

 

Available Roles for UCD-323 and UCD-323 Gen2 

• DisplayPort Reference Sink (SST, HDCP 2.3) 

• DisplayPort Reference Source (SST, HDCP 2.3) 

• DisplayPort Reference Source (MST – 2 streams, HDCP 2.3) 

• HDMI Reference Source (HDCP 2.3) 

• HDMI Reference Sink (HDCP 2.3) 

• HDMI Reference Sink (eARC) 
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Change Device Configuration 
UCD-300 devices can feature up to four simultaneous Roles. Changing the role configuration is 

done by selecting the firmware packages loaded to the UCD-300 device. For selecting you need 

to open UCD Config.  

In the first window, select Enable advanced mode. Click next. 

In the second window, select the device you want to configure. Click next. 

 

In the third window select MC3XX. Click next. 

 

In the fourth window, select the roles for the device. Click next. 

 

 

In the fifth window click Start. 
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License Manager 

Licensing 

The features of UCD Console GUI are divided into groups based on the target use of the device. 

Most basic features can be used by default, and more advanced feature groups are enabled by 

dedicated licenses. When the licenses are present, the related part of the GUI will be shown, or 

the related control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables 

a dedicated function in one device. Each device has its dedicated Seed Number. Each License 

Key is tied to one Seed Number. License Keys can be freely used in any number of PCs. 

License keys are managed with UCD License Manager. License manager can be found in the 

Tools menu of UCD Console . 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices 

please Select the device in question. The serial number and the seed number of your device are 

printed in a sticker attached to the bottom of the device.  

The Rescan… button will re-scan the system for installed hardware. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 
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Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the 

field for new licenses. The License Manager will automatically move the caret across the edit 

boxes during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install. The license is authenticated and if it is valid, 

the license will appear in the list of installed licenses. If the key fails to authenticate, an error 

message is displayed. If this happens, please make sure that the key has been typed correctly 

and that the seed number on the license key sticker matches the seed number displayed in UCD 

License Manager. 

Click the Search inverted triangle at the upper right to view the Find edit control. Enter a search 

keyword: The license list is updated to show names that contain the keyword. 

Please note that to avoid confusion, some letters will never appear in a license key because they 

resemble numbers: For example, capital 'G' and number '6' are very similar when printed with 

small font. When in doubt, use numbers. 

Also, please notice, that characters that cannot be part of valid license key are not accepted as 

input. When appropriate, an automatic conversion is applied while typing: For example, lower case 

letters are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the 

name of the license and the actual license key characters. 

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button. 

Export will allow installed licenses for the currently selected device to be saved into an INI file for 

backup and distribution to other PCs. To export license(s), click on the license(s) and then click 

the Export button. Please notice that licenses from multiple devices can be exported into the same 

INI file. 

Import will install licenses from an INI file for the currently selected device. 
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UCD Console 

UCD Console is graphical user interface (GUI) for UCD family test equipment for desktop use. 

UCD Console provides the user access to all features of the unit. UCD Console also includes 

powerful debugging and analysis tools enabling the user to monitor the status of the display 

interfaces and assist in problem detection.  

In UCD Console the various features of the UCD unit are divided into interface specific screens 

and tabs. Each tab contains data and controls for a specific feature.  

Note: This version of the User Manual describes features in UCD Console software based on the 

functionality in Microsoft Windows operating system.  

 UCD Console is also available for macOS operating system to be used in iMac and MacBook 

computers and for Linux operating system. Detailed description of the macOS and Linux versions 

will be added later. 

Device Selection 
A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console GUI is launched, the dialog provides a list of Unigraf UCD devices connected 

in the PC. Please select the target device by clicking on the appropriate button. If your device 

cannot be found in the list, please confirm the power and USB connection to the device and click 

the Rescan … button. 

Analyzer and Generator Operation 
Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator 

(a Source device). In default configuration UCD-3XX devices can operate in one role at a time.  

The operating role is selected when the device is opened in UCD Console. For changing a role, 

please close the device (File > Close Device), click Rescan … if needed, and select the new role.  

This User Manual will explain all roles available for UCD-3XX devices and the functionalities 

available for each role.  
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UCD Console Menu 

File 

 

Open Device Open a device. You can have several UCD Consoles open 

simultaneously with different devices. 

Close Device Closes device. The device selection window will open. 

Exit Close UCD Console. 

Tools 

 

Firmware Update Opend UCD Config for firmware update. 

License Manager Opens License Manager. 

Packet Editor Opens packet editor. 

Image Converter Opens UICL converter. 

Pattern Editor Opens pattern editor. 

Options See below. 
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Options 

 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM 

format the files are stored with the captured color depth, with other formats the color depth is 

truncated to 8 bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP compliance 

Shows if the monitors used are HDCP compliant. Previewing HDCP encrypted content is only 

possible with HDCP compatible displays. 

Folders 

Please select the directories in the PC for saving the captured images and audio. 

DSC 

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related configuration files and 

DSC conversion tools are stored. 

Keep auto-created DSC 

content files 

By default, the DSC compressed content is deleted after use. If 

selected, the content is not deleted 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for 

running the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large 

(appr. 400 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 
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DUT Testing Options 

Include time info in report 

logs 

Include time info in reports of tests run in Sink / Source DUT testing 

tab. 

Don’t show ‘test sequence 

completed’ 

Don’t show dialog after tests run in Sink / Source DUT testing tab. 

 

Window 

 

In the window menu you can export and import layout of UCD Console including the tab order. 

You can also reset layout to factory settings. 

Help 

 

SDK Opens SDK folder installed during installation of UCD Console. Folder 

inclused C, python and test automation scripts 

Documentation Open UCD Console User Manual. 

About UCD Console Show UCD Console information including software and firmware 

versions. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and 

controlling separate features simultaneously. To detach a tab Right-click on a tab and select 

Detach Window. To glue the tab back to the main window, click on the red Close button in the 

top right-hand corner of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

or HDMI SCDC simultaneously without swapping addresses. To clone a tab Right-click on a tab 

and select Clone Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, UCD-3XX devices act as DisplayPort o HDMI Sink or Receiver devices. 

User is selecting device role when opening the Device when launching UCD Console. Selecting 

DP Reference Sink or HDMI Reference Sink, UCD Console operates as Analyzer. 

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, 

Interface Specific tabs present features and controls that are only available for a particular 

interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Standard Tabs 

Analyzer role features the following standard tabs: 

• Video preview and saving (Video) 

• Capturing video, audio and metadata. (Capture) 

• Audio monitoring and saving (Audio) 

• EDID editor (EDID) 

• HDCP status monitor and control (HDCP) 

• Source DUT Testing tab 

• Event Log 

Interface Specific Tabs 

Based on the connected UCD device, additional interface specific tabs will be available. 

 

DP Reference Sink 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

DPCD 
For monitoring and editing the DPCD 

registers of the DP Sink 

SDP 
Showing the Secondary-Data Packets sent 

by the Source device 

AUX Controller 

AUX controller allows UCD-323 to make 

Source DUT to train link at a specific link 

configuration or to output a test pattern. 

 

HDMI Reference Sink 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

InfoFrames Received InfoFrame packets 

CEC 
For sending and receiving CEC protocol 

messages and data. 

 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing. 
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Standard Tabs 

Video Tab 
Video tab is the Preview window for the captured video frames. 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Video Status 

The details of the captured video are presented below the preview window. 

First row: Counter, frame size, frame rate, color mode, color depth, frame counter. 

Second row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Third row: Live preview frame rate. 

 

Note: Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. Live preview frame rate is limited e.g by the USB communication between UCD test 

equipment and the PC. 
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Override Color Detection 

 

The captured video will be by default automatically converted to RGB 8 bpc for preview and saving 

based on the information in video metadata.  

By clicking Auto button, a dialog opens for overriding the automatic conversion. Captured image 

data will be interpreted based on the values set in the dialog.  

 

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

 

Note: Please note that the color mode selection applies to the preview window only. All internal 

functions use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 
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Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of 

the preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the color components of the pixel on the cursor location in HEX. Expressed 

as RGB and YCbCr. 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25% 

• Zoom 50% 

• Zoom 100% 

• Zoom 200% 

• Zoom 500% 

Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of 

the preview image and selecting Save as…. The format and storage location can be selected in 

the opening dialog. The available bitmap formats are BMP, JPG, PNG, and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color 

depth is truncated to 8 bits per color. 



  Analyzer Operation 

 

UCD-3XX User Manual • UCD Console 3.9 37. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from 

the display interface or if the color mode conversion selected for preview will be applied. 

 

Open 

 

Open folder where captured frames are stored. Double click or click Open to select a frame file 

for viewing. You can select the storage folder in Tools > Options. 

Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen or press Esc to exit full screen mode. 
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Frame Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. 

In addition, audio and metadata can be captured and saved for later analysis. Video can be stored 

as RGB or RAW data.  

Start / Stop Start or stop capturing. When capturing Start button label changes to 

Stop. 

Capture N frames …: The number of video frames captured. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Capacity of buffer: The number of video frames that can be stored to UCD frame buffer 

using current video signal format 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked, the binary data is aligned to the Least 

Significant Bit (LSB).  

Create scenarios Define the length of the scenario 

Events: Please refer to chapter Event Log for details of the captured events. 

Audio Enable audio. 

Status: Status of the capture. 

Open Timeline Viewer Open Timeline Viewer to view the captured data. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is “buffered_capture_yyyymmdd_hhmmss” (e.g., 

buffered_capture_20210301_130532). 

 

Note: Video Preview needs to be disabled to use Data Capture functionality. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and 

recording. Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum 

display can be selected between ‘Linear’ to 100 dB. 

The span of the oscilloscope preview window is defined with Playback buffer found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Playback buffer depends on the 

sampling frequency. Please do not exceed the Main buffer set in the same dialog. Please refer to 

description of the Video Audio and Misc Options earlier in this document. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current 

Stream selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # 

below the panels is increasing. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in 

the host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD-300 EDID. Since UCD-300 is not performing 

any audio format conversion, it might occur that the source provides an audio format that the 

selected playback device is not supporting. In case a conflict occurs, please change manually the 

EDID content, or disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream and the 

number of audio packets captured. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID and Display ID of the UCD-300 Sink presented to 

the Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents either in EDID Editor or in hex format 

• Program and read the contents of the EDID memory of up to two virtual MST Ports  

(with UCD-323 special configuration) 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code is read. If the device is not supporting all four blocks, the 

non-supported area is replaced with blanks. 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) 

status and controlling the HDCP capabilities of the UCD-300 device. 

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 

Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been 

encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

Configuration 

HDCP Capable:  To disable HDCP uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 / 1.4 vs. HDCP 2.3 

UCD-3XX devices support by default HDCP 1.3 / 1.4 standard. The functionality for supporting 

HDCP 2.2 / 2.3 is enabled with HDCP 2.3 Support license 
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Source DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available. 

Run: Run a selected test. You can select a test for running by clicking on the 

corresponding row. When selected, the row will be highlighted in blue. 

Run Checked: Click to start checked tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: Select 

All, Clear All, Invert All, Save, Import and Export 

Configure: Clicking opens a dialog for defining the test parameters for the selected test 

set. Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

 

At the completion of each test the result of the test is indicated in the matrix on the right hand side 

of the test panel. For each test the matrix lists the number of occurrences of each result and the 

number of tries performed. 

Save Report: Click to generate a HTML report file for sharing the results with other parties 

for viewing without UCD Console. 

Clear Selected: Clear the results matrix for selected tests 

Clear All: Clear the test log and the results matrix 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in 

Appendix E of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with 

TSI scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or 

with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all parameter dialogs the selected parameters can be saved as Presets. Please click Presets… 

to save or recall a configuration.  
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DP Reference Sink 

Role: Product: 

DP Reference Sink (DP RX)    UCD-323, UCD-323 Gen2, UCD-301 

 

When roles DP Reference Sink is in use, the following interface specific tabs are available: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

DPCD 
For monitoring and editing the DPCD 

registers of the DP Sink 

SDP 
Showing the Secondary-Data Packets sent 

by the Source device 

AUX Controller 

AUX controller allows UCD-323 to make 

Source DUT to train link at a specific link 

configuration or to output a test pattern. 

 

DP Link Tab 
Link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between 

UCD Sink and the Upstream Source. It also lists status of other link modes. The data is retrieved 

from the DPCD status registers of the UCD Sink. The status is updated automatically. 

 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt 

Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

Error count: Content of DPCD Error Count registers 

ILA:   LED indicator for ‘Inter lane Alignment Done’  

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (8b/10b) 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced) 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Not Supported 

SSC Status: Status of Spread-Spectrum Clock (Enabled or Disabled) 

DSC Status: Not Supported 

FEC status: Not Supported 

 

Link Training Result 

The result of the previous Link Training and values of some key parameters. 

 

Link Capabilities 

Link capabilities allow the user to change the way the Sink capabilities are announced in the DPCD 

capability registers of the UCD Sink. Maximum Lane Count and Maximum Link Rate are set with 

their corresponding radio buttons. 
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Force cable status to 

plugged: 

When checked, sink functionality is active regardless of a failure of 

upstream device detection e.g., due to incorrect AUX Channel 

electrical termination.  

Enable Fast LT: Indicates support for link training without AUX transactions. 

TPS4, TPS3: Indicate support for Link Training Pattern Sequence 4 and 3 

correspondingly. 

HPD pulse on Apply: Select to apply a Hot-Plug Detect (HPD) pulse automatically after 

updating the status. HPD pulse duration will be defined in the Pulse 

HPD field in HPD dialog in the bottom of the tab. 

To update the new status to the DPCD registers click Apply. 

 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description.  

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 

HDCP Configuration 

Enable and disable HDCP 1.3 or HDCP 2.3 capability of UCD Sink. Duplicates of the controls 

found in HDCP tab 

Scrambler seed (8b/10b) 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during 

scrambler reset.  

Stream Info 

Video Stream Info are retrieved from the Main-Stream Attributes (MSA) and SDP packets of the 

monitored stream. Frame rate is measured by UCD Local Sink.  
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The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel 

count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel 

count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. 

CEF Used color mode: Color format + subsampling / 

colorimetry. In case of YCbCr formats detailed info 

gained from VSC SDP. 

BPC Color depth in bits per color (BPC) 

CRC 

(RGB/CrYCb) 

16-bit Cyclic redundancy check (CRC) value per color component 

calculated from active pixels. Value order in YCbCr color format: Cr, Y, 

Cb. 

MVID/NVID Mvid and Nvid video time stamp values 

 

The MSA information used for Video Timing Details is provided by the Upstream Source, it is not 

measured by the UCD Local Sink. 

HPD 

 

Cable: LED indicates that the hardware has detected an upstream cable.  

HPD: LED indicates that the HPD signal is Asserted (logical “high”). 

Deassert: Click button to set HPD line to logical “low” (de-asserted) and hence no 

HPD pulse can be generated.  

Assert: Click to re-activate the HPD line (set to logical “high”). 

Pulse HPD: Click to apply an HPD Pulse with programmable duration. Duration will be 

defined in the provided field. 

Short Pulse: Click to apply a short pulse. Duration will be defined in the provided field. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the DP Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background. 

DPCD Decoder flags in Tools > Options contain control of DETAILED_CAP_INFO_AVAILABLE 

flag. 

 

 

Refresh: Re-read the data from the DPCD registers to 

the window in question 

Write 

Changes: 

Write the portion of data shown in the 

window in question to the DPCD registers. 

Set 

Reference: 

Store currently shown data as a reference for 

comparison 

 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted in 

blue. The fields edited by the user will be highlighted in red. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are two 

alternative formats listed below. Please select the format when saving: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can also 

load the DPCD content stored in this format. 

• HEX Dump (*.HEX) in a human readable text format. 

Save: Store DPCD content to a file.  

Load: Recall DPCD data saved in DPCD Data File (*.DPD) format to the editor.  
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SDP Tab 
In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Refresh to re-

read the data. Show / hide the parsed data by clicking on the arrow in the divider bar. 

The following packets are recognized: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC (International Standard Recording Code) 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 
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• Picture Parameter Set (PPS) 

 

Saving SDP Packets 

Packets can be saved in a file in binary format. Click Save and in the dialog select the packet 

types of choice. File name will be of format ATS_2022-07-28T15_54_24.bin, where ATS is the 

packet type and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document. 
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  Analyzer Operation 

 

UCD-3XX User Manual • UCD Console 3.9 53. 

AUX Controller Tab 
AUX controller allows UCD-323 to make Source DUT to train link at a specific link configuration 

or to output a test pattern. It does this in so-called Routed LT mode in which UCD-323 sends 

predefined responses to source's AUX requests, ignoring actual main link data. 

AUX controller supports both 8b/10b and 128b/132b rates. Link presets are different: VS/PE for 

8b/10b and FFE for 128b/132b. Test patterns are also different for 8b/10b and 128b/132b and 

128b/132b. Select a 128b/132b rate to see the difference. 

Old DP2.0 LT is an older procedure for 128b/132b LT (2-stage instead of new 3-stage LT). It is 

needed sometimes for debugging 

Note: AUX Controller tab is enabled with a separata license. For detailed information, refer to Appendix 

B in this document. 

Routed Link Training 

Status displays: the Routed LT Mode (colored means it is active), the LT State (Not Started or 

Finished) and the LT Result (Successful or blank). 

Old DP 2.0 LT checkbox lets you do old type 2.0 (128b/132b) link training (see above). 

Select Disable/Enable button to toggle Routed Link Training. 

Select Force LT with HPD pulse to send HPD pulse and initiate Link Trainging. 

Select Request LT via TA to train via test automation. 

PHY test pattern 

Select test pattern via combo box:  

For 8b/10b: CP2520_1, CP2520_2, PRBS7, SERM, TPS1 and TPS2. 

For 128b/132b: LTTPR CLOCK SWITCH test, PRBS11, PRBS15, PRBS23, PRBS31, PRBS9, 

SQnum, SQnum_Pre_Dis_Post_Dis, SQnum_Pre_Dis_Post_En, SQnum_Pre_En_Post_Dis, 

TPS1_128b_132b, TPS1_128b_132b. 
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Press Request pattern via TA to request pattern via test automation. 

Request Link Configuration 

 

 

Select the desired parameters for Link Training via radio buttons: 

 

DP Lane Count: Choose between 1, 2 or 4 lanes  

DP Bitrate, Gbps Available options: 1.62, 2.70, 5.40, 6.75, 8.10, 10, 13.5, 20 

eDP Bitrate, Mbps: Set the eDP bitrate in Mbps  

DP PHY Presets VS and PE levels 

Pulse HPD: Click to apply an HPD Pulse with programmable duration. 

Duration will be defined in the provided field. 

Short Pulse: Click to apply a short pulse. Duration will be defined in the 

provided field. 

 

Adjustable AUX voltage swing 

 

Select Enable checkbox to enable, Choose desired swing in edit control and press Set to apply. 

 

Note: Adjustable AUX voltage swing is only available wth UCD-323 Gen2. 
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HDMI Reference Sink 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323, UCD-323 Gen2 

 

When HDMI Reference Sink role is in use, the following interface specific tabs are available: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

InfoFrames Received InfoFrame packets 

CEC 
For sending and receiving CEC protocol 

messages and data. 

eARC eARC status and control 

 

HDMI Link Tab 
Link tab contains four panels: Behavior, Status, Audio Return Channel, HDCP Status and 

Configuration, Video Status and HPD. 

Behavior 

Selection of HDMI operation mode: HDMI 1.4 or HDMI 2.0 Please perform HPD Deassert -Assert 

after change of mode. 

Status  

Channel lock Indication of channel lock status in TMDS links 0 to 2 

Error count Status of SCDC Error Count Registers 
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Behavior HDMI operation mode (HDMI 1.4 or HDMI 2.0) 

TMDS Status  

Mode: Indication of HDMI / DVI mode 

TMDS Bit Clock Ratio: TMDS Bit Period / TMDS Clock Period ratio (1/10 or 1/40)  

Input Stream Lock: Indication of TMDS character lock 

Audio Return Channel 

Enable: Select to enable eARC function. 

Source: Select the eARC audio Source to be either 

- Loopback of captured HDMI audio, or 

- Audio received in the S/PDIF input 

Mode: Select eARC mode 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 

HDCP Configuration 

Enable and disable HDCP 1.3 or HDCP 2.3 capability of UCD Sink. Duplicates of the controls 

found in HDCP tab. 
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Video Mode 

Timing and color mode details of the video as retrieved from stream metadata. Frame rate is 

measured by UCD Local Sink.  

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. To re-calculate, click Update. Click Copy to store the 

information in Windows clipboard. 

HPD 

HPD LED: Indicates that the HPD signal is Asserted (logical “high”). 

Assert: Click to re-activate the HPD line (set to logical “high”). 

Deassert: Click button to set HPD line to logical “low” (de-asserted) and hence no 

HPD pulse can be generated. 
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InfoFrames Tab 
InfoFrames Tab is enabled with UCD Pro for HDMI Sink license. Please click Refresh to re-read 

the InfoFrame data. 

Packet info 

When you select an infoframes, the corresponding row is highlighted in blue and the information 

of the infoframes is shown on the right hand. 

Features 

Features Tab shows indicators for ALLM, HDR10+ and Dolby. Please, note that the indicators are 

show only when compatible content is played. 

 

 

Note: When the played content changes, users must use the HPD controls to first Deassert and then 

Assert to update the upcoming infoframes. After HPD asserting, click Refresh. 

Save 

Click Save to open the selection packs dialog. The following received infoframes are available: 

• ACR (Audio Clock Regeneration) 

• ASP (Audio Sample Packet) 

• GCP (General Control Packet) 

• ACP (Audio Content Protection Packet)  

• ISRC1 (International Standard Recording Code) 

• ISRC2 (International Standard Recording Code) 

• OBA (One Bit Audio sample packet) 

• DTS (DTS Audio packet) 

• HBR (High Bitrate Audio stream packet) 

• GMP (Gamut Metadata packet) 

• 3D ASP (3D Audio Sample packet) 
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• 3D OBA (3D One Bit Audio sample packet) 

• AMP (Audio Metadata Packet) 

• MST_ASP (Multi-stream audio sample packet) 

• MST_OBA (One Bit Multi-stream audio sample packet) 

• VSI (Vendor Specific InfoFrame) 

• AVI (Auxiliary Video Information) 

• SPD (Source Product Descriptor) 

• AIF (Audio InfoFrame) 

• MPEG (MPEG Source InfoFrame) 

• DRM (Dynamic Range and Mastering InfoFrame) 

Saving Infoframes 

Infoframe packets can be saved in a file in binary format. Click Save and in the dialog select the 

packet types of choice. File name will be of format EMP_2022-07-28T15_54_24.bin, where EMP 

is the packet type and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 

 

CEC Tab  
 

The CEC Tab is used for sending and receiving CEC (Consumer Electronics Control) protocol 

messages and data. 

The CEC Tab is grouped into two panels: CEC Info and CEC Controls. 
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CEC Controls 

Use CEC Controls to send data a HDMI follower via CEC protocol. Select Add button to add an 

Operation code with parameters to be sent to various devices. 

 

 

Logical address: Logical address of destination 

Phy address: Physical address of destination 

Destination: Destination device 

Operation code: Operation code to send 

OP Parameter: Operation code parameter to send 

Device type: Sender device type 

 

Select the rows of items in the table (or press the Select AllI button) and press Send button to 

transmit via HDMI CEC protocol. 

Select the rows of items in the table (or press the Select AllI button) and press Rermove to delete 

items. 
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Select the Presets button to Save… , Load, Remove, Import… , or Export item sets as shown 

above. 

CEC Info 

CEC data and status received can be seen in the CEC info panel. 

 

CEC Status shows the CEC Version, Operation number and Buffer status. You can also enable 

CEC response. Press Refresh button to refresh. 

CEC Data shows the CEC data received. Select Reset All or Reset to remove all or selected rows. 

Select Refresh to check for new data. 
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Remote 

The interface simulates the function of a remote control. 

 

 
Power Toggle  

 
Up 

 
Power on 

 
Down 

 
Power off 

 
Left 

  
Root menu 

 
RIght 

  

Exit 

 
Select 

   

Channel up 

Channel down 
 

Volume up 

Volume down 

 

CEC Flow 

 
Logical address (initiator)  

 
Logical address (destination) 

ADDR Physical address 
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eARC Tx (enhanced Audio Return Channel 

Transmitter) 

Note: The eARC role needs to be enabled for HDMI RX in device configuration. For instructions, refer 

to Change Device Configuration. 

 

eARCTx Status 

Mode: Active eARC mode(Arc/eArc/None) 

Audio Latency: Audio latency of eArcRX in milliseconds 

eARC State: Active eARC state (H14bARC, IDLE1, IDLE2, DISC1, DISC2, EARC) 

Heartbeat: Heartbeat status (only for eARC mode) 

  

eARCTx Controls 

eARC Mode: Select disabled, eARC, legacy ARC or None 

Audio Latency request: Set the audio latency request in milliseconds 

Audio Mode: Set audio mode as HDMI audio bypass or generator in eARC TX 

Apply: Click to apply settings 
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eArcTX Audio Generator 

Audio Status 

Audio status shows the info on the loaded audio content: amount of channels, sample rate (Hz) 

and bits/sample. 

Play Control 

Start or stop playing audio. Audio source and status also shown. 

Audio Content 

Either generate audio or load audio from a file. 

Channels: Select 1, 2, 3, 4, 5, 6, 7 or 8  

Bits/Sample: Select 16, 20 or 24 

Sample Rate (Hz): Select 32000, 44100, 48000, 88200, 96000, 176400 or 192000 

Waveform: Select sine, sawtooth, square, incremental or ping 

Signal Frequency: Set a value between 1 and 20000 

Amplitude (%): Select 10, 20, 30, 40, 50, 60, 70, 80, 90 or 100 

Same signal for all 

channels: 

Uses same sample rate, waveform, signal frequency and amplitude for all 

channels. If not checked, values are selected for each channel individually. 

Presets: Save, Load, Remove, Import and Export audio content settings. 

 

 

 

Path: Audio file location 

Open WAV file…: Load WAV audio file 

Compressed: Compressed audio 

 

eARC Descriptors 

This is eARC Rx EDID. eARC EDID is presented with Audio block and describes Audio capabilities 

for eARC RX. 
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 GENERATOR OPERATION 
When used as a Generator UCD-3XX devices act as DisplayPort or HDMI Source or Transmitter 

devices. 

User is selects device role when opening the Device when launching UCD Console. Selecting DP 

Reference Source or HDMI Reference Source, UCD Console operates as Generator. 

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, 

Interface Specific tabs present features and controls that are only available for a particular 

interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Standard Tabs 

Generator role features six standard tabs: 

• Video pattern generator (Pattern Generator). 

• Content Playback (Playback) 

• Audio generator (Audio) 

• EDID editor (EDID). 

• HDCP status monitor and control (HDCP). 

• Sink DUT Testing 

• Event Log 

Interface Specific Tabs 

Based on the connected UCD device, additional interface specific tabs will be available. 

UCD-323, UCD-323 Gen2 

 

DisplayPort Reference Source: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

DPCD 
For monitoring and editing the DPCD 

registers of the connected DisplayPort sink 

 

HDMI Reference Source: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

SCDC 
Presents content of HDMI Status and 

Control Data Channel 

 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing. 
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Standard Tabs 

Pattern Generator Tab 

Auto-Apply In order to avoid sourcing invalid video mode combinations new 

settings are being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Use timings from EDID UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings Please see chapter Manage Timings later in this manual 

Total bitrate Used link payload / Total link capability in Gbps 

Apply Apply recent changes 

 

Pattern Generator Status 

 

Pattern Generator Status window shows the current state of the video stream including timing, 

pattern, CEF, BPC and status. 
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Timing and Pattern Controls 

 

Controls include selection of Predefined Timings, Color Depth, Video Pattern and Pattern Options. 

Predefined Timings 

 

The list includes a set of common fixed video timings. Please find a list of the timings with their 

major details in Appendix C of this document. With Manage Timings function the user can add 

timings to the list and limit which timings are shown in the selection. 

Filter 

 

Filter timings by specific vendors and resolutions. Click Enable to use filters. Timings can be 

sorted by Vendor ID or width. 

 

Color Depth 

 

Available color depths are: 6, 8, 10, 12 and 16 bpc. Color depth 6 bpc is only available when using 

RGB color format in DisplayPort. 

Quantization Range 

VESA 8 bits per color ranges transmitted with full color bits: 0 to 255. 

CTA 8 bits per color ranges transmitted with limited color bits: 16 to 235. 

Video Pattern 

 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 
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Custom Image Patterns 

 

BMP, PNG, and JPG files can be loaded from the PC to be used as custom images. The bitmaps 

will be aligned to the top left corner, displayed at their original resolution, no scaling, cropped to 

the used active area. 

Please refer to Link Pattern in description of DP Reference Source role Link tab later in this manual 

for sending special binary patterns in the link instead of video.  

Color Mode, Color Depth and Colorimetry 

 

The table below lists the available color modes and related available color depths. Please, note 

that YCbCr color modes are only available with specific patterns such as color square pattern. 

 

Selection Color 

Format 

Subsampling Available Color Depths Available Colorimetry 

RGB: RGB 4:4:4 6, 8, 10, 12 and 16 bpc N/A 

YCbCr444: YCbCr 4:4:4 8, 10, 12 and 16 bpc SMPTE 1 and ITU 709 

YCbCr422: YCbCr 4:2:2 8, 10, 12 and 16 bpc SMPTE 1 and ITU 709 

YCbCr420: YCbCr 4:2:0 8, 10, 12 and 16 bpc SMPTE 1 and ITU 709 

 

Aspect Ratio 

Available in UCD-323 with HDMI Tx role. Aspect ratio data for infoframes. Available options are 

no data, 4:3 and 16:9. 

 

Pattern Options 

 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 

Timing Generator 

Generate CTA or OVT timings.  
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Timing controls 

 

 

Users can use the fields to modify the timing details. 

MST (UCD-323 special FW configuration) 

Multistreaming is available with UCD-323 FW configuration:  

“DisplayPort Reference Source (MST – 2 streams, HDCP 2.3)” 

Check-box for enabling Multi-stream mode and number of streams sourced. Duplicate of controls 

in Link tab. When MST is enabled, the streams can also be enabled and disabled from the check-

boxes next to stream name. 

Note: The video modes that can be used in MST streams are limited by the overall capability of the 

DisplayPort link and the capability of the connected DisplayPort Sink or Branch device.  

Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can 

be limited by un-checking the check-box in the left edge of Name column. The timings will remain 

in the list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon  indicates that a timing is 

a fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon 

. 
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New: Create a new custom timing based on the selected fixed timing. 

Save: Save changes in the selected custom timing. 

The dialog will make a sanity check for the values entered and will warn the user for combinations 

that cannot be used. 
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Playback Tab 
Playback allows for running predefined Playlist files. Playlist contains a set of Scenarios with 

definitions of the timing, video pattern, audio content and related metadata packets and their 

duration. You can import playlists by clicking Import. 

Term Functionality 

Playlist 

Playlists (text files) specify the UCD devices 

and output protocol for transmission. It lists 

scenarios to be transmitted. 

Scenario 

Scenarios (text files) allow users to select 

video frames, metadata packets and audio 

to be transmitted and their order. 

Advanced Playlists 

Unigraf UCD devices can be used as 

compatibility test tools for dedicated 

standards such as Dolby Vision™ and 

HDR10+. Contact Unigraf for details. 

 

Note: Please note that Playlists and Scenarios are protocol dependent.  

The provided examples are also somewhat different for HDMI and DisplayPort. 
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Common Tab 

The Import button is for importing *.json files into the common tab treeview. Sample content on 

windows can be found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\ 

basic_library.json. Be warned that once imported, items cannot at present be removed. Actually 

you can but it involves using Windows Register Editor to remove values from (uninstall will not 

help): 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\Playback 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\MetadataScenario 

Sample playlists are included in UCD Console. Select a sequence (a playlist or scenario) from the 

Sample Content treeview and  press Run (or double click it) to play. 

The Run button label changes to Stop as a Scenarios run. Press Stop to stop playing the scenario. 

Press Skip to skip to next scenario (available when there are multiple scenarios in a playlist) while 

playing. While the scenario is loading the Run button label changes to Cancel to allow cancelation. 

 

 

 

Status Log 

Scenario commands are listed in the Status Log as they are run. 
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Selected Sequence 

Running scenario video and audio details and their sources are shown in the Selected Sequence 

group panel. 

Note that the triggered scenario or playlist to be run is the last selected: If an item was selected 

via the treeview, it is the triggered item to be run. If the Select button was used to select an item, 

it is the triggered item to be run (regardless of what is selected in the tree control). 

Press the Select button to load a playlist or scenario to be run (selecting a sample from the Sample 

Content treeview will load them as the playlist or scenario to be run). It will also be the scenario 

used as a template if the Scenario Editor is launched: default scenario values will be set if a playlist 

is selected. 

Press the Editor button to launch the Scenario Editor (see below). 

The Selected Sequence group panel displays transmission parameters. 
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Metadata Tab 

 

The Metadata tab is for creating scenarios with metadata. 

 

 

Select the Delete button to delete a scenario or the Generate button to launch the Custom 

Metadata Scenario dialog (shown below). 

 

 

Current Pattern Generator timing details are shown at the top (CTA 1920 x 1080 @ 60Hz (VIC 0) 

above). You can change the color mode (RGB444, YUV444, YUV422, YUV420) and color depth 

(8 bpc, 10 bpc, 12 bpc, 16 bpc) via the dropdown combo boxes. 

Select the Add or Delete buttons to add or remove metadata from the scenario. 

Check the Audio checkbox and then the Browse… button to add an audio file. Sampling, channels 

and bits can be selected via the combo boxes. 

The scenario Comment can be added in line edit box after the three dashes (---). 

Use the Content folder Browse… button to select save location. 

You can press Play to run the scenario, Export to save it or Cancel to cancel. 

Export will create a folder something like Metadata1920x1080@60-RGB444-8bpc in the Content 

folder. In it you will find generated files frame.svg (displayed while running), the metadata files you 

selected and a scenario.txt file. You may edit and rename these files. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

 

Adaptive-Sync Tab 

 

Select Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator 

window will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 
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Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. 

Different transition types are Fixed frame rate, Min and max and Gradual.  

When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 

 

When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how 

many times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min 

frame rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be 

incremented by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate 

defined in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You 

can select the speed of the spinner video from the predefined options in the drop-down menu or 

you can set a number of frames it takes for the spinner to rotate a full circle. You can also select 

a custom video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 
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Available memory is shown in bytes and frames. Below, the folder selected for the sequence is 

shown. You can change the folder by clickin Browse… Lastly, the duration of the sequence is 

shown in frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown 

below. 
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  Generator Operation 

 

UCD-3XX User Manual • UCD Console 3.9 82. 

Scenario Editor 

 Press the Select button (shown above) to select a playlist scenario desired to use as a template 

for creating a new scenario. Press the Editor button to launch the Scenario Editor. The the dialog 

parameters will be generated from the scenario file shown under the panel Source label (Philips 

FHD.txt as seen above) or default values if a playlist is selected. 

Press OK to save. You are presented with a save dialog. You need to navigate to a directory you 

can save to. Run Console 2 with administration rights if you want to save to default locations on 

windows such as: C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Refer to Appendix H: Playlists and Scenarios later in this manual for details. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description. 

VRR/QMS tab 

 

Click Generate to generate custom VRR and QMS scenarios. Custom Scenario Generator window 

will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on 

the pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) 

and color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 

 



  Generator Operation 

 

UCD-3XX User Manual • UCD Console 3.9 84. 

VRR settings 

In the VRR tab you can set the transition and scenario duration parameters. Different transition 

types are Fixed frame rate, Min and max and Gradual. When fixed frame rate is selected, the 

scenario is played at the minimum frame rate set in the first field. Please, note that when the fixed 

frame rate is selected, you can only select the number of times the frame is repeated. 

 

When min and max is selected, the output scenario will alter the framerate between the specified 

values. You can also set the duration for step in seconds and select how many times frames are 

repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min 

frame rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be 

incremented by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate 

range defined in EDID, and the base frame rate set in the pattern generator. 

 

QMS settings 

In the QMS settings dialogue you find all the frame rates included in the QMS specification. Select 

which frame rates you want to include in your scenario. Also select the step duration in cycles. In 

the lower left corner details of the scenario as shown. 

 



  Generator Operation 

 

UCD-3XX User Manual • UCD Console 3.9 85. 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You 

can select the speed of the spinner video from the predefined options in the drop-down menu or 

you can set a number of frames it takes for the spinner to rotate a full circle. You can also select 

a custom video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is 

shown. You can change the folder by clicking Browse… Lastly, the duration of the sequence is 

shown in frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

includes the image files, packets, and scenario parameters. 

You can play the scenario by clicking Play. When the scenario is ready for playing, the scenario 

generator window will close. You can now inspect the progress in the log in the playback tab as 

shown below. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV 

format. 

To load internally generated audio, select Generate audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load audio from file, click the Open WAV file… button, 

browse and select the file and Open. 

The Compressed checkbox indicates that the audio loaded from the selected file is compressed. 

To play the selected audio content, click Play. 

The content will be transmitted until the Stop button is clicked.  

Audio Status displays current audio content status.   

Audio Content 

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Channels Audio channels available: 1, 2, …, 7, 8. 

Channels transmit LPCM (uncompressed) Audio. 

Sample Rate (Hz) Selection of audio sampling rate:  

32000, 44100 (default), 48000, 88200, 96000, 176400, 192000. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental. 

Signal Frequency Setting audio signal frequency in Hz. 

Bits/Sample Selection of sample bit depth: 16, 20, 24. 

Amplitude(%) Selection of audio amplitude: 10%, 20%, …, 90%, 100%. 

Same signal for all 

channels 

When deselected, you can choose the waveform, amplitude, signal 

frequency and shift separately for each individual channel 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) 

status and controlling the HDCP capabilities of the UCD-300 device. 

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 

Status 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded HDCP keys are loaded to the UCD unit. 

RX uses Test ey  

Km stored  

Control 

Enable encryption Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Keys 

Select between Production and Facsimile HDCP keys. To remove the keys, select None.  

Content level 

Selection of Type 1 content ensures that content encryption is done with HDCP version 2.2 or 

higher. 

HDCP 1.3 / 1.4 vs. HDCP 2.3 

UCD-300 devices support by default HDCP 1.3 / 1.4 standard. The functionality for supporting 

HDCP 2.2 / 2.3 is enabled with HDCP 2.3 Support license 
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EDID Tab 
EDID Tab provides tools for accessing the EDID and Display ID of the connected DisplayPort sink. 

There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents either in EDID Editor or in hex format 

• Program and read the contents of the EDID of the connected sink 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code is read. If the device is not supporting all four blocks, the 

non-supported area is replaced with blanks. 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document 
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Sink DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available. Sink DUT 

Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Sink DUT. Sink DUT 

Testing enables testing of a DP Sink DUT. Please refer to Appendix E of this document to get a 

full definition of the Test Cases and test parameters.  

Select the tests for execution by clicking the corresponding row. 

Run: Run a selected test. You can select a test for running by clicking on the 

corresponding row. When selected, the row will be highlighted in blue. 

Run Checked: Click to start checked tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: Select 

All, Clear All, Invert All, Save, Import and Export 

Configure: Clicking opens a dialog for defining the test parameters for the selected test 

set. Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

 

At the completion of each test the result of the test is indicated in the matrix on the right hand side 

of the test panel. For each test the matrix lists the number of occurrences of each result and the 

number of tries performed. 

Save Report: Click to generate a HTML report file for sharing the results with other parties 

for viewing without UCD Console. 

Clear Log: Clear the test log and the results matrix 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in 

Appendix E of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with 

TSI scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or 

with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… 

to save or recall a configuration.  
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DP  Reference Source 

When role DP Reference Source is in use, the following interface specific tabs are available: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

DPCD 
For monitoring and editing the DPCD 

registers of the connected DisplayPort sink 

MST 2 Streams MST 2 streams in pattern generator 

 

DP Link Tab 
Link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between the 

connected Sink and the UCD Source. It also lists status of other link modes. The data is retrieved 

from the DPCD status registers of the connected Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization. 

VS/PE (level): Voltage Swing / Pre-emphasis level. 

Error count: Content of DPCD Error Count registers. 

ILA:   LED indicator for ‘Inter lane Alignment Done. 

EQ_ILA: Disabled with 8b/10b link coding. 

CDS_ILA: Disabled with 8b/10b link coding. 

LT_FAIL: Disabled with 8b/10b link coding. 

Bit rate: Currently enabled link bit rate. 

Link mode: Currently enabled channel coding (8b/10b). 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced). 

Scrambling: Status of link data scrambling (Enabled or Disabled). 

MST mode: Status of the Multistreaming (MST) mode (only in UCD-323 special FW 

configuration). 

SSC Status: Not Supported. 

DSC Status: Not Supported. 

FEC status: Not Supported. 

 

Send ACT: Force sending an Allocation Change Trigger (ACT) sequence over Main-Link.  

Link configuration 

Set target capabilities for the link training. Click Link Training to apply.  

DP Lane Count (8b/10b) Lane count used. 
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DP Bitrate (8b/10b), Gbps Link rate used . 

Enhanced Framing Mode Enable Enhanced Framing Mode. 

EQ pattern (8b/10b) Pattern (8b/10b) to be used for equalization: auto, TPS2, TPS3,TPS4. 

 

Link Overrides 

Override Voltage Swing and Pre-emphasis selected during link training. Click Apply to validate 

changes. Overrides are applied immediately to DPTX transceiver when 'Apply' is clicked. Please 

note, that It affects main link signal amplitude and pulse shape only. No AUX exchange takes 

place. The change can be checked only with a scope. Overrides are removed at the beginning of 

the next link training. 

 

Link Pattern 

Select between Active video and audio, Idle pattern, or special bit patterns.  

Active Video Transmit Video Pattern, Audio and Metadata 

Idle Pattern Link is active but no stream data is being transmitted 

Training Pattern 1 Send Link Training Pattern Sequence 1 (TPS1) 

Training Pattern 2 Send Link Training Pattern Sequence 2 (TPS2) 

Training Pattern 3 Send Link Training Pattern Sequence 3 (TPS3) 

Training Pattern 4 Send Link Training Pattern Sequence 4 (TPS4) 

PRBS7 Send PRBS7 Link Quality Test Pattern 

HBR2 Compliance EYE pattern Send HBR2 Compliance EYE pattern 

SER (Symbol Error Rate) Send Symbol Error Rate Measurement pattern 

Force Video Character error messages from sink will not interrupt video 

transmission. 

Force Idle Link Training and Active Video will not be initiated even after a 

re-plug 
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Stream Info 

Stream Info is retrieved from the Main-Stream Attributes (MSA) of the monitored stream.  

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC 16-bit Cyclic redundancy check (CRC) value per color component calculated from 

active pixels 

VFREQ Video Frequency (128b/132b channel coding only) 

 

HDCP Status 

Duplicate of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document 

for detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.3 or HDCP 2.3 encryption. Duplicates of the controls found in HDCP 

tab. 

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 
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HPD 

Asserted: LED indicates status of Hot Plug Detect (HPD) signal 

Scrambler seed (8b/10b) 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during 

scrambler reset.  
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected DisplayPort or 

DisplayPort Alt Mode Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to a binary DPCD Data file (*.DPD). 

Load: Select previously saved binary DPCD Data file (*.DPD). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with 

blue color. The fields edited by the user will be highlighted with red color. 

 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are three 

alternative formats listed below. Please select the intended format when saving: 

• Binary DPCD Data File format (*.DPD). This is Unigraf proprietary format. You can also load 

the DPCD content stored in this format. 

• Comma Separated Value format (.CSV) 

• HEX Dump (*.HEX) in a human readable text format. 
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MST – 2 Streams 
MST – 2 streams role enables two streams for the pattern generator. For detailed description of 

the pattern generator, please refer to Patten Generator Tab. 

Note: The MST – 2 Streams role needs to be enabled for DP TX in device configuration. For instructions, 

refer to Change Device Configuration. 

 

MST-2 pattern generator supports only predefined patterns. Custom patterns are not supported. 

Apply all: Appl settings for streams 0 and 1 

MST: Enable MST 
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HDMI Reference Source 

When roles HDMI Source is in use, the following interface specific tabs are available: 

Tab: Description: 

Link 
Status information and control of the 

upstream link 

SCDC 
Presents content of HDMI Status and 

Control Data Channel 

 

HDMI Link Tab 
Link tab is enabled by default. 

HDMI Behavior 

Selection of the HDMI version to be used (HDMI 1.4 or HDMI 2.0). 

Status 

Channel lock Indication of channel lock status in TMDS links 0 to 2 

Error count Status of SCDC Error Count Registers 

Behavior HDMI operation mode (HDMI 1.4 or HDMI 2.0) 

Video: Video data available 

TMDS Status 

Mode TMDS mode (HDMI or DVI) 

TMDS Bit Clock Ratio: Status of TMDS_Bit_Clock_Ratio bit in SCDC – TMDS Configuration 

(1/10 or 1/40) 

Scrambling: Status of TMDS_Scrambler_Status bit in SCDC – TMDS Scrambler 

Status (1=LED on; 0=LED off) 
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HDCP Status 

Note: Please note that HDCP 1.3 is not supported in 3.9 release. 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.3 or HDCP 2.3 capability of UCD-422 Sink. Duplicates of the controls 

found in HDCP tab. 

HPD 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-asserted 

(logical “low”). 
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SCDC Monitor 
SCDC monitor presents content of HDMI Status and Control Data Channel (SCDC) structured by 

its address range. 

The SCDC Monitor panel on the right hand side shows the interpretation of the SCDC byte 

selected on the monitoring windows. The selected byte is shown with a green outline.  

Click Refresh to re-read the data from the SCDC registers to the window in question.  

Click Write Changes to write the portion of data shown in the window in question to the SCDC 

registers. 

 Click Set Reference to store currently shown data as a reference for comparison.  

When the data is Refreshed from the SCDC registers the changed bytes will be highlighted with 

blue color. 

The fields edited by the user will be highligted with red color. 

Saving and Loading SCDC Content 

SCDC data in the selected address areas can be saved as a file in your PC. There are two 

alternative formats listed below. Please add the intended format when saving: 

• Binary SCDC Fata File format (*.DPD). This is Unigraf proprietary format. You can also load 

the SCDC content stored in this format. 

• HEX Dump (*.HEX) in a human readable text format. 

 Click Save to select the location and the format of the file.  

 Click Load to load SCDC data saved in SCDC Data File (*.DPD) format to the editor.  

 To program the data into the SCDC registers of UCD Local Sink click Write Changes. 

CEC Tab 
Source CEC Tab functions in exactly the same manner as for Sink CEC Tab CEC Tab. 
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Packet Generator 
Packet generator enables configuring and generating Custom SDP independently from the Audio 

and Video Pattern Generators. 

Note: In Packet Generator the packet generation time is limited. After limitation generator must be 

restarted manually. For UCD-323 the limit is approximately 1 hour. 

 

 

 

Add: Add new packets. Opens packet editor. 

Edit: Edit existing packets 

Remove: Remove selected packet 

Remove All: Remove all packets 

Start: Start transferring the packets 

Presets: Save, Load, Remove, Import or Export packets 

Save as… Save packet 

Load: Load packets 

Packet editor 

For detailed information on the packet editor, please refer to Packet Editor chapter in this manual. 
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 UCD TIMELINE VIEWER 

Role: Product: 

DP Reference Sink (DP RX) UCD-323 Gen2, UCD-323, UCD-301 

HDMI Reference Sink (HDMI RX) UCD-323 Gen2, UCD-323, UCD-301 

 

UCD Timeline Viewer is an application for inspecting data captured in capture tab. It consists of four areas. 

1. Frame View 

2. Event View 

3. Event Log 

4. Details / Image 

 

Frame View 

 

The uppermost panel shows the captured frames. The selected frame is highlighted in purple. You can select a 

frame by double-clicking it. The area highlighted in green indicates the area shown in the Events view. Please, 

note that you cannot zoom in or out in the frame view. 

Event View 

 

The view below shows all frames and events selected in the capture tab. The are highlighted in green in frame 

view indicates the are shown in events view. 

  

1 

2 

3 

4 
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Tools 

Tool Function 

 Gear Icon Hide / add events on the timeline 

 Save Icon 
Save, load, remove, import, export and 

remove presets 

 Magnifying Glass Icons Zoom in/out on the timeline 

 Arrow Icons 

Move on the timeline. More arrows moves 

the timeline more. You can also move by 

clicking and dragging in the timeline. 

 Move to a time point 

Move to a certain time point on the timeline 

by double clicking on the timeline. The 

selected event is highlighted in the event 

log. By right clicking on the timeline and 

right clicking again you can measure 

distance between two time points. 

 Erase all rulers Erase all measurements made. 

 

Zooming on the timeline

 

Went the timeline is zoomed out, you can see events as grey lines. When you zoom in you can 

see the event block. You can zoom in either with the magnifying glass icons or by scrolling with 

your mouse. 

 

When you double click on event or frame, the corresponding event or frame is selected in the 

event log and highlighted in purple. 
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Event Log 

 

Event log shows all captured events and frames. The following info is presented in the table: 

Type Function 

ID Number of captured frame 

Start Start of the event 

Duration Duration of the event 

End End of the event 

Info Additional information about the event. 

 

Event Log Tools 

 Search  
Search events from the event log. Search 

results are highlighted in purple. 

 Apply search filters Apply filters. 

 Search filters 
Aa filter: Make search case sensitive 

RExp: Use regular expressions in search 

 Search results 

Shows search results. Move from one 

search result to another by clicking the 

arrows. 

 Configure 
Selec which columns are shown in event 

log. 
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Details / Image 

 

Details tab shows details of the selected event. When the selected event is a frame, the image tab 

shows the captured frame. 
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 EVENT LOG 
Event Logger (Event Log) collects time stamped information from the display interface. The type 

of data items logged is dependent on the display interface used and the role selected. 

Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 

 

Role Logged Events 

DP Sink 

 

HPD, SDP, AUX Transactions 

HDMI Sink HPD, Packets, I2C, CEC 

DP Source 

 

HPD, AUX Transactions 

HDMI Source HPD, I2C, CEC 

DP Alt Mode Sink 

 

PD, LSE 

 

Start: Starts event logging and stop it by clicking Stop. 

Save: Save transactions as Event Log data. 

Load: Load saved Event Log data. 

Report: Store event logs as html reports to be shared and viewed with any web 

browser. 

Open Timeline Viewer Open captured data for viewing in timeline viewer. 

AutoScroll: When selected, transaction list is scrolled vertically, and the latest 

transaction is shown as the last item of the list. When not selected, the 

items shown before clicking Start will be shown. 

Events Number of events detected. 

Clear: Click to clear transaction list. When Clear on Start is selected, the list is 

cleared when clicking Start. 
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Logged Events 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal. 

SDP 

Secondary-data Packets received in DP Main-Link. Click the button to open the Event Filter 

Dialog. The dialog enables filtering of SDP packets. In the dialog, the reference to Packet Type 

Value is indicated in square brackets “[ ]”. 

AUX 

DP AUX Channel transactions. 

Packets 

Log metadata sent by Source device in HDMI lanes. 

 

I2C 

Log data sent over I2C communication lines of HDMI interface. 

PD 

Log USB-C PD communication messages. 
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LSE 

Low Speed Electrical logger captures the Voltage and Current on the low-speed lanes of the 

USB-C connector including CC, VBUS, VCONN, and SBU. 

In Event Filter Dialog the user can set the noise threshold values. Only measurement exceeding 

the corresponding threshold will be logged. 
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional 

information about the data line, facilitating its viewing and interpretation. 

Start: Each line is identified by its timestamp, marking the instant when an event 

or error was detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the 

acquisition (absolute) or from the previous line (relative).  

The timestamp can be displayed in milliseconds or in minutes, seconds, 

and microseconds. 

Source and Type The communication port: DP RX to DP TX 

Type The logged item: HPD, SDP, AUX, MSA Change or VB-ID change 

Info This column provides a short description of the message content 
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Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. User can also color highlight various types of transactions 

for better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from start of logging 

• Time from device reboot 

• Time from previous event 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second) 

• Hours : minutes : seconds : milliseconds : nanoseconds 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by 

changing character color and background color of the transaction line. 

 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change order where rules are applied.  

The rules are applied from the bottom to the top of the list. 
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Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent 

on the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from Available list can be 

included in Active columns by selecting it and clicking on the right arrow [>] in the middle of the 

two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list 

with up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can 

limit the list to show only the reads or writes to this DPCD address. 
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Parsed Transactions 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal. 

AUX (UCD-301, UCD-323, UCD-323 Gen2) 

DP AUX Channel transactions. 
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SDP (UCD-301, UCD-323, UCD-323 Gen2) 

DP Secondary-data Packets.  

Packets (UCD-301, UCD-323, UCD-323 Gen2) 

Log metadata sent by Source device in HDMI stream 

 

I2C (UCD-301, UCD-323, UCD-323 Gen2) 

 Log data sent over I2C communication lines of HDMI interface 
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 EDID EDITOR 

The EDID/DisplayID Editor main window is divided into three views. Command buttons are 

Additionally located in the bottom. The top left Navigation View selection focuses and highlights 

the Editor View (top-right) and Hex Editor View (bottom-right). The Editor View values may be 

edited when the Editor Mode checkbox is checked. Hex Editor View presents blocks as hex values 

and can be edited when the HEX Edit Mode checkbox is checked. 

Controls 
Add Item Add a new EDID or DisplayID block. Available when in Editor Mode 

exclusively. 

Remove Item Delete the selected EDID or DisplayID block. Available when in Editor 

Mode exclusively. 

Filter Show only items having the filter string in their field name. 

Editor Mode Enable editor mode 

Read mode Select EDID data reading mode: 

I2C (using I2C protocol) or SBM (MST mode only): virtual channels read 

via SBM protocol. 

Show Read Only Automatically generated non-editable fields are additionally shown. 

Recurse All subitems of the selected item are presented in Editor View. 
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The buttons in the bottom of the dialog differ based on the role selected, i.e., is the subject the 

local EDID or EDID of a connected device. 

Main Features: The Main features panel gives an overview of items of 

common interest. For example, whether the sink is capable of 

HDR, or Dolby Vision. The small grey italic text shows 

corresponding location in EDID. If you click on the Value cell, 

the corresponding address in the HEX mode table is shown. 

 

 

Read from TE (Analyzer): Read UCD-3XX local EDID. 

Write to TE (Analyzer): Program UCD-3XX local EDID. Please see the Note below. 

Read from TE (Generator): Read EDID of a connected sink device. 

Write to TE (Generator): Program EDID of a connected sink device. 

Editor Mode: Enable editing EDID content in parsed logical fields. When 

disabled, all the controls are in read-only mode. For example, 

for testing purposes it’s possible to load invalid EDID and 

write it to TE without modifications. Once editor mode is 

enabled, EDID validator corrects errors such as invalid 

checksums. Modifications are possible in the upper panel 

with Name – Value pairs. 

HEX Edit Mode: Enable editing EDID content in HEX mode table. When 

enabled, modifications are possible in the lower panel with 

HEX values. Click the Apply button to validate the changes 

and copy them to the upper panel. 

Save As…: Save the current block collection to a disk file. 

Load …: Load an EDID block collection file from disk. 

EDID Editor Features 
A practically unlimited number of extension blocks may exist in a single collection. The number 

of blocks is limited by VESA Specifications and possibly by available system resources. Most 

EDID/DisplayID blocks contain a structure that is very similar to a tree structure. The Editor 

decodes each block into a tree view of the block. The tree view then contains all values within the 

data block. Contents can be browsed. The Editor has a support for automatic variables, such as 

the block checksum. When a value in a block is modified, the checksum will be updated. Automatic 

variables are read only. A log print will be made when an automatic variable is updated by the 

editor.  

Editing Tips 
Editing is straightforward: 

Select property fields to edit. 

Red values in HEX View show that values have been modified. 
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Press Enter to apply edit values and combo box selections. 

In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”.  

Enter hex values with prefixes “0x” or “$”.  No prefix represents a decimal value. 

Values may be entered as hexadecimal or decimal regardless of  presentation. 

Floating point values must have a period “.” decimal separator. 

Click Set after changing a bit-value presented as a single checkbox if you want the new 

value applied. 

Note: EDID Editor does not have an Undo function. Therefore, it is highly recommended that you back 

up un-edited EDID contents to a file before editing it. 
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 PACKET EDITOR 

Introduction 

Packet Editor enables creation and editing metadata packets to be included Scenarios played 

with Playback function. Open packet editor from UCD Console’s menu Tools > Packet Editor. 

The types of packets are: 

• Audio InfoFrame (Audio) 

• AVI InfoFrame (AVI) 

• Custom InfoFrame (Custom) (HDMI) 

• Custom Packet (custom) (DP) 

• DR&M InfoFrame (DR&M) (HDMI) 

• DR&M Packet (DR&M) (DP) 

• EMP-VRR (EMP-VRR) 

• GCP InfoFrame (GCP) 

• SBTM InfoFrame (SBTM) (HDMI) 

• SPD InfoFrame (SPD) 

• Vendor-Specific InfoFrame (VS) (HDMI)* 

• Vendor-Specific SDP (VS) (DP)* 

 

*) Please select from available VS packet types in field “4: Type” in the packet editor. 
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 PATTERN EDITOR 

Introduction 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. Open 

packet editor from UCD Console’s menu Tools > Pattern Editor. 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of 

the VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 
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Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of 

the preview image in Image tab. 

Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script 

will be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. Open the 

image converter from UCD Console’s menu Tools > Image Converter. 

Click Upload files to load the Source image.  

 

 

Colorspace YCbCr, RGB 

Colorimetry ITU-R BT.601, ITU-R BT.709, ITU-R BT2020 

Sampling 4:4:4, 4:2:2, 4:2:0 

Bit depth 8, 10, 12, 16 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB). 

Change resolution Select a resolution for the destination image from the pre-defined list 

Covert All Convert all uploaded images to destination format and save them in the 

same folder as the source images. 

Covert All and save to 

the custom folder 

Convert all uploaded images to destination format and save to the 

selected folder. 

 

File name for the destination image is of form: 

Test image[1920x1080_yuv444_8bpc_BT601_Packed_YCbCr_LSB] 
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APPENDIX A: PRODUCT SPECIFICATION 

UCD-301 
Inputs DisplayPort™ 1.4a compliant with HBR2 max bit rate  

HDMI 2.0 compliant 

Max video mode 4096 × 2160 p60 input 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Electrical Test Verify electrical continuity of input signals 

Computer interface USB 3.0 and USB 2.0 

Software Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

System input: 12Vdc, 3A 

Environmental 

Operating temperature: 15 to 40 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 281 × 128 × 62 mm 

Weight 0.9 kg w/o power supply 

UCD-323 
Inputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP in) 

HDMI 2.0 compliant (HDMI in) 

Outputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP out) 

HDMI 2.0 compliant (HDMI out) 

Max video mode 4096 × 2160 p60 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Capture memory 4 GBytes 

Computer interface USB 3.0 and USB 2.0 

Software Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

System input: 12Vdc, 3A 

Environmental 

Operating temperature: 15 to 40 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 281 × 128 × 62 mm 

Weight 0.9 kg w/o power supply 
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UCD-323 Gen2 
Inputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP in) 

HDMI 2.0 compliant (HDMI in) 

Outputs DisplayPort™ 1.4a compliant with HBR2 max bit rate (DP out) 

HDMI 2.0 compliant (HDMI out) 

Max video mode 4096 × 2160 p60 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Capture memory 4 GBytes 

Computer interface USB 3.0 and USB 2.0 

Software Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

System input: 12Vdc, 3A 

Environmental 

Operating temperature: 15 to 40 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 281 × 128 × 62 mm 

Weight 0.9 kg w/o power supply 
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APPENDIX B: PRODUCT FEATURES 

UCD-301, UCD-323 & UCD-323 Gen2 

Interface Role / Product Option 
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HDMI Reference Sink                   

Video status, preview and saving ●     ▲    

Audio monitoring, graphical preview and saving ●     ▲    

Link status ●     ▲    

Link control  ●     ▲   

HPD status and control ●     ▲    

EDID read and write  ●     ▲   

EDID Editor  ●        

HDCP 1.4 status and control   ●     ▲   

HDCP 2.3 status and control    ●      ▲ 

Event Log  ●        

Infoframe status  ●     ▲   

Source DUT Testing  ●     ▲ ▲  

Electrical Test (UCD-301)  ●      ▲  

eARC (UCD-323 Gen2)  ●        

DP Reference Sink          

Video status, preview and saving ●     ▲    

Buffered capture  ●        

Audio monitoring, graphical preview and saving ●     ▲    

Link status ●     ▲    

Link control  ●     ▲   

HPD status and control ●     ▲    

DPCD editor  ●        

Monitor InfoFrame Status (SDP)  ●     ▲   

EDID read and write  ●     ▲   

EDID / DisplayID Editor  ●        

HDCP 1.3 status and control**  ●        

HDCP 2.3 status and control    ●      ▲ 

Event Log, AUX Analyzer  ●        

AUX Controller     ●     

Source DUT Testing (Link and CRC test)  ●     ▲   

Electrical Test UCD-301  ●      ▲  

HDCP 2.3 CTS for testing DP Source DUT     ●      

*) Separate licenses for testing Sink and Source DUT 

**) HDCP 1.3 is not supported for 3.9 release 
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UCD-301, UCD-323 & UCD-323 Gen2 (cont.) 
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HDMI Reference Source (UCD-323 only)                

Video pattern generator (fixed patterns and timings) ●      ▲  

Custom video patterns and timings  ●      ▲ 

Playback  ●      ▲ 

Audio Generator ●        

Link status ●       ▲ 

Link control  ●      ▲ 

EDID read and write  ●      ▲ 

EDID Editor  ●       

SCDC Editor  ●      ▲ 

Event Log  ●       

Sink DUT Testing  ●       

HDCP 1.4 status and control   ●      ▲ 

HDCP 2.3 status and control    ●      

DP Reference Source (UCD-323 only)         

Video pattern generator (fixed patterns and timings) ●     ▲   

Custom video patterns and timings  ●     ▲  

Audio generator ●        

Playback  ●     ▲  

Link status ●     ▲   

Link control  ●       

HPD status ●      ▲  

EDID read and write  ●     ▲  

EDID / DisplayID Editor  ●       

MST Feature (up to 2 streams) ●     ●   

DPCD editor  ●       

HDCP 1.3 status and control**  ●     ▲  

HDCP 2.3 status and control    ●      

Event Log, AUX Analyzer  ●       

AUX Controller     ●    

Sink DUT Testing  ●       

HDCP 2.3 CTS for testing DP Sink DUT     ●     

 

**) HDCP 1.3 is not supported for 3.9 release 
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UCD-301, UCD-323 & UCD-323 Gen2 Product Options 

 

Product P/N 

UCD-300 Series SW Options 

UCD Console Pro for HDMI Reference Sink MT6610 

UCD Console Pro for DP Reference Sink MT6611 

UCD Console Pro for HDMI Reference Source MT6613 

UCD Console Pro for DP Reference Source MT6614 

HDCP 2.3 support MT6504 

HDCP 2.3 CTS Options for UCD-301, UCD-323 

HDCP 2.3 CTS for testing Source DUT on DP  MT6634 

HDCP 2.3 CTS for testing Sink DUT on DP  MT6636 

SDK Options for UCD-301, UCD-323, UCD-323 Gen2 

TSI SDK Advanced Test Set MT6501 

TSI SDK Adv. Test Set with HDCP 2.3 support  MT6516 

TSI Electrical Test Set MT6502 

HDR10+ Options for UCD-323 

HDR 10+ Display Device and SSTM for testing Sink DUT on HDMI MT6675 

HDR 10+ Display Device and SSTM for testing Sink DUT on DP MT6676 

HDR 10+ Distribution Device for testing Source DUT on HDMI MT6677 

HDR 10+ Distribution Device for testing Source DUT on DP MT6678 

PHY CTS Options for UCD-323 Gen2 

DP 2.1 Reference Sink AUX Controller for testing Source DUT 065060 

DP 2.1 Reference Source AUX Controller for testing Sink DUT 065061 
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APPENDIX C: PREDEFINED TIMINGS 

Description TSI* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CVT 640x480 @60Hz 0 640 480 800 525 144 35 96 2 60 25.20 

CTA 640x480 @60Hz (VIC 1) 1 640 480 800 525 144 35 96 2 60 25.17 

CTA 720x480 @60Hz (VIC 2) 2 720 480 858 525 122 36 62 6 60 27.00 

CTA 720x480 @60Hz (VIC 3) 3 720 480 858 525 122 36 62 6 60 27.00 

CTA 720x576 @50Hz (VIC 17) 4 720 576 864 625 132 44 64 5 50 27.00 

CTA 720x576 @50Hz (VIC 18) 5 720 576 864 625 132 44 64 5 50 27.00 

CTA 720x576 @100Hz (VIC 42) 6 720 576 864 625 132 44 64 5 100 54.00 

CTA 720x576 @100Hz (VIC 43) 7 720 576 864 625 132 44 64 5 100 54.00 

CTA 720x480 @120Hz (VIC 49) 8 720 480 858 525 122 36 62 6 120 54.00 

CTA 720x480 @120Hz (VIC 48) 9 720 480 858 525 122 36 62 6 120 54.05 

CTA 720x576 @200Hz (VIC 52) 10 720 576 864 625 132 44 64 5 200 108.00 

CTA 720x576 @200Hz (VIC 53) 11 720 576 864 625 132 44 64 5 200 108.00 

CTA 720x480 @240Hz (VIC 56) 12 720 480 858 525 122 36 62 6 240 108.00 

CTA 720x480 @240Hz (VIC 57) 13 720 480 858 525 122 36 62 6 240 108.00 

CVT 768x480 @85Hz 14 768 480 992 507 184 24 72 6 85 42.50 

OVT 768x480 @85Hz 15 768 480 928 741 64 242 32 8 85 58.45 

DMT 800x600 @60Hz (DMT 0x09) 16 800 600 1056 628 216 27 128 4 60 40.00 

DMT 848x480 @60Hz (DMT 0x0E) 17 848 480 1088 517 224 31 112 8 60 33.75 

CVT 1024x640 @60Hz 18 1024 640 1312 665 248 22 104 6 60 52.25 

DMT 1024x768 @60Hz (DMT 0x10) 19 1024 768 1344 806 296 35 136 6 60 65.00 

OVT 1024x640 @60Hz 20 1024 640 1240 660 64 16 32 8 60 49.10 

CVT 1152x720 @75Hz 21 1152 720 1520 755 304 32 120 6 75 85.75 

OVT 1152x720 @75Hz 22 1152 720 1280 1224 64 496 32 8 75 117.50 

CTA 1280x720 @50Hz (VIC 19) 23 1280 720 1980 750 260 25 40 5 50 74.25 

CTA 1280x720 @100Hz (VIC 41) 24 1280 720 1980 750 260 25 40 5 100 148.50 

CTA 1280x720 @24Hz (VIC 60) 25 1280 720 3300 750 260 25 40 5 24 59.40 

CTA 1280x720 @25Hz (VIC 61) 26 1280 720 3960 750 260 25 40 5 25 74.25 

CTA 1280x720 @30Hz (VIC 62) 27 1280 720 3300 750 260 25 40 5 30 74.25 

CTA 1280x720 @24Hz (VIC 65) 28 1280 720 3300 750 260 25 40 5 24 59.40 

CTA 1280x720 @25Hz (VIC 66) 29 1280 720 3960 750 260 25 40 5 25 74.25 

CTA 1280x720 @30Hz (VIC 67) 30 1280 720 3300 750 260 25 40 5 30 74.25 

CTA 1280x720 @50Hz (VIC 68) 31 1280 720 1980 750 260 25 40 5 50 74.25 

CTA 1280x720 @60Hz (VIC 69) 32 1280 720 1650 750 260 25 40 5 60 74.25 

CTA 1280x720 @100Hz (VIC 70) 33 1280 720 1980 750 260 25 40 5 100 148.50 

CTA 1280x720 @120Hz (VIC 71) 34 1280 720 1650 750 260 25 40 5 120 148.50 

CTA 1280x720 @48Hz (VIC 108) 35 1280 720 2500 750 260 25 40 5 48 90.00 

CTA 1280x720 @48Hz (VIC 109) 36 1280 720 2500 750 260 25 40 5 48 90.00 

CTA 1280x720 @60Hz (VIC 4) 37 1280 720 1650 750 260 25 40 5 60 74.25 

CTA 1280x720 @120Hz (VIC 47) 38 1280 720 1650 750 260 25 40 5 120 148.50 

OVT 1280x720 @24Hz 39 1280 720 1600 925 64 194 32 8 24 35.52 

OVT 1280x720 @120Hz 40 1280 720 1408 775 64 38 32 8 120 130.94 
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CVT 1280x768 @60Hz 41 1280 768 1440 790 112 19 32 7 60 68.26 

DMT 1280x768 @60Hz (DMT 0x17) 42 1280 768 1664 798 320 27 128 7 60 79.67 

OVT 1280x768 @60Hz 43 1280 768 1472 800 64 20 32 8 60 70.66 

DMT 1280x800 @60Hz (DMT 0x1B) 44 1280 800 1440 823 112 20 32 6 60 71.11 

DMT 1280x800 @60Hz (DMT 0x1C) 45 1280 800 1680 831 328 28 128 6 60 83.76 

OVT 1280x960 @60Hz 46 1280 960 1440 1000 64 24 32 8 60 86.40 

DMT 1280x960 @60Hz (DMT 0x20) 47 1280 960 1800 1000 424 39 112 3 60 108.00 

CVT 1280x960 @60Hz 48 1280 960 1696 996 336 33 128 4 60 101.25 

DMT 1280x1024 @60Hz (DMT 

0x23) 
49 1280 1024 1688 1066 360 41 112 3 60 107.96 

DMT 1360x768 @60Hz (DMT 0x27) 50 1360 768 1792 795 368 24 112 6 60 85.48 

DMT 1400x1050 @60Hz (DMT 

0x29) 
51 1400 1050 1560 1080 112 27 32 4 60 101.09 

DMT 1400x1050 @60Hz (DMT 

0x2A) 
52 1400 1050 1864 1089 376 36 144 4 60 121.79 

CTA 1440x480 @60Hz (VIC 6) 53 1440 480 1716 525 238 18 124 3 60 54.00 

CTA 1440x480 @60Hz (VIC 7) 54 1440 480 1716 525 238 18 124 3 60 54.00 

OVT 1440x240 @60Hz 55 1440 240 1920 260 64 14 32 8 60 29.95 

CTA 1440x240 @60Hz (VIC 8) 56 1440 240 1716 263 238 18 124 3 60 27.00 

CTA 1440x240 @60Hz (VIC 9) 57 1440 240 1716 262 238 18 124 3 60 27.00 

CVT 1440x240 @60Hz 58 1440 240 1716 262 238 18 124 3 60 27.00 

OVT 1440x480 @60Hz 59 1440 480 1696 500 64 12 32 8 60 50.88 

CTA 1440x480 @60Hz (VIC 14) 60 1440 480 1716 525 244 36 124 6 60 54.00 

CTA 1440x480 @60Hz (VIC 15) 61 1440 480 1716 525 244 36 124 6 60 54.00 

CTA 1440x576 @50Hz (VIC 21) 62 1440 576 1728 625 264 22 126 3 50 54.00 

CTA 1440x576 @50Hz (VIC 22) 63 1440 576 1728 625 264 22 126 3 50 54.00 

CTA 1440x288 @50Hz (VIC 23) 64 1440 288 1728 314 264 22 126 3 50 27.00 

CTA 1440x288 @50Hz (VIC 24) 65 1440 288 1728 314 264 22 126 3 50 27.00 

CTA 1440x576 @50Hz (VIC 29) 66 1440 576 1728 625 264 44 128 5 50 54.00 

CTA 1440x576 @50Hz (VIC 30) 67 1440 576 1728 625 264 44 128 5 50 54.00 

CTA 1440x576 @100Hz (VIC 44) 68 1440 576 1728 625 264 22 126 3 100 108.00 

CTA 1440x576 @100Hz (VIC 45) 69 1440 576 1728 625 264 22 126 3 100 108.00 

CTA 1440x480 @120Hz (VIC 50) 70 1440 480 1716 525 238 18 124 3 120 108.00 

CTA 1440x480 @120Hz (VIC 51) 71 1440 480 1716 525 238 18 124 3 120 108.00 

CTA 1440x576 @200Hz (VIC 54) 72 1440 576 1728 625 264 22 126 3 200 216.00 

CTA 1440x576 @200Hz (VIC 55) 73 1440 576 1728 625 264 22 126 3 200 216.00 

CTA 1440x480 @240Hz (VIC 58) 74 1440 480 1716 525 238 18 124 3 240 216.00 

CTA 1440x480 @240Hz (VIC 59) 75 1440 480 1716 525 238 18 124 3 240 216.00 

OVT 1440x900 @60Hz 76 1440 900 1600 940 64 23 32 8 60 90.24 

DMT 1440x900 @60Hz (DMT 0x2F) 77 1440 900 1904 934 384 31 152 6 60 106.50 

OVT 1536x960 @85Hz 78 1536 960 1640 1440 64 469 32 8 85 200.74 

CVT 1536x960 @85Hz 79 1536 960 2080 1011 432 48 160 6 85 178.50 

CVT 1600x1200 @60Hz 80 1600 1200 1760 1235 112 32 32 4 60 130.42 

DMT 1600x1200 @60Hz (DMT 

0x33) 
81 1600 1200 2160 1250 496 49 192 3 60 162.00 

CTA 1680x720 @24Hz (VIC 79) 82 1680 720 3300 750 260 25 40 5 24 59.40 

CTA 1680x720 @25Hz (VIC 80) 83 1680 720 3168 750 260 25 40 5 25 59.40 

CTA 1680x720 @30Hz (VIC 81) 84 1680 720 2640 750 260 25 40 5 30 59.40 
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CTA 1680x720 @50Hz (VIC 82) 85 1680 720 2200 750 260 25 40 5 50 82.50 

CTA 1680x720 @100Hz (VIC 84) 86 1680 720 2000 825 260 100 40 5 100 165.00 

CTA 1680x720 @48Hz (VIC 110) 87 1680 720 2750 750 260 25 40 5 48 99.00 

CTA 1680x720 @60Hz (VIC 83) 88 1680 720 2200 750 260 25 40 5 60 99.00 

CTA 1680x720 @120Hz (VIC 85) 89 1680 720 2000 825 260 100 40 5 120 198.00 

DMT 1680x1050 @60Hz (DMT 

0x39) 
90 1680 1050 1840 1080 112 27 32 6 60 119.23 

DMT 1680x1050 @60Hz (DMT 

0x3A) 
91 1680 1050 2240 1089 456 36 176 6 60 146.36 

DMT 1792x1344 @60Hz (DMT 

0x3E) 
92 1792 1344 2448 1394 528 49 200 3 60 204.75 

DMT 1856x1392 @60Hz (DMT 

0x41) 
93 1856 1392 2528 1439 576 46 224 3 60 218.27 

CTA 1920x1080 @60Hz (VIC 5) 94 1920 1080 2200 1125 192 20 44 5 60 148.50 

CTA 1920x1080 @50Hz (VIC 20) 95 1920 1080 2640 1125 192 20 44 5 50 148.50 

CTA 1920x1080 @50Hz (VIC 31) 96 1920 1080 2640 1125 192 41 44 5 50 148.50 

CTA 1920x1080 @24Hz (VIC 32) 97 1920 1080 2750 1125 192 41 44 5 24 74.25 

CTA 1920x1080 @25Hz (VIC 33) 98 1920 1080 2640 1125 192 41 44 5 25 74.25 

CTA 1920x1080 @50Hz (VIC 39) 99 1920 1080 2304 1250 352 62 168 5 50 144.00 

CTA 1920x1080 @100Hz (VIC 40) 100 1920 1080 2640 1125 192 20 44 5 100 297.00 

CTA 1920x1080 @120Hz (VIC 46) 101 1920 1080 2200 1125 192 20 44 5 120 297.00 

OVT 1920x1080 @30Hz 102 1920 1080 2144 1100 64 14 32 8 30 70.75 

OVT 1920x1080 @60Hz 103 1920 1080 2080 1120 64 27 32 8 60 139.78 

OVT 1920x1080 @85Hz 104 1920 1080 2016 1623 64 529 32 8 85 278.12 

OVT 1920x1080 @100Hz 105 1920 1080 2016 1380 64 286 32 8 100 278.21 

OVT 1920x1080 @120Hz 106 1920 1080 2016 1150 64 56 32 8 120 278.21 

OVT 1920x1080 @144Hz 107 1920 1080 2040 1175 64 68 32 8 144 345.17 

OVT 1920x1080 @240Hz 108 1920 1080 2000 1215 64 117 32 8 240 583.20 

CTA 1920x1080 @100Hz (VIC 64) 109 1920 1080 2640 1125 192 41 44 5 100 297.00 

CTA 1920x1080 @24Hz (VIC 72) 110 1920 1080 2750 1125 192 41 44 5 24 74.25 

CTA 1920x1080 @25Hz (VIC 73) 111 1920 1080 2640 1125 192 41 44 5 25 74.25 

CTA 1920x1080 @30Hz (VIC 74) 112 1920 1080 2200 1125 192 41 44 5 30 74.25 

CTA 1920x1080 @50Hz (VIC 75) 113 1920 1080 2640 1125 192 41 44 5 50 148.50 

CTA 1920x1080 @60Hz (VIC 76) 114 1920 1080 2200 1125 192 41 44 5 60 148.50 

CTA 1920x1080 @100Hz (VIC 77) 115 1920 1080 2640 1125 192 41 44 5 100 297.00 

CTA 1920x1080 @120Hz (VIC 78) 116 1920 1080 2200 1125 192 41 44 5 120 297.00 

CVT 1920x1080 @30Hz 117 1920 1080 2080 1096 112 13 32 5 30 68.39 

CVT 1920x1080 @30Hz 118 1920 1080 2000 1096 72 14 32 8 30 65.76 

CVT 1920x1080 @144Hz 119 1920 1080 2080 1157 112 74 32 5 144 346.66 

CVT 1920x1080 @144Hz 120 1920 1080 2000 1157 72 14 32 8 144 333.33 

CVT 1920x1080 @144Hz 121 1920 1080 2080 1157 152 14 32 8 144 346.66 

CVT 1920x1080 @200Hz 122 1920 1080 2080 1190 152 14 32 8 200 495.21 

CVT 1920x1080 @240Hz 123 1920 1080 2080 1215 112 132 32 5 240 606.27 

CVT 1920x1080 @240Hz 124 1920 1080 2000 1215 72 14 32 8 240 582.95 

CVT 1920x1080 @240Hz 125 1920 1080 2080 1215 152 14 32 8 240 606.27 

CTA 1920x1080 @30Hz (VIC 34) 126 1920 1080 2200 1125 192 41 44 5 30 74.25 

CVT 1920x1080 @60Hz 127 1920 1080 2080 1111 112 28 32 5 60 138.65 

CVT 1920x1080 @60Hz 128 1920 1080 2000 1111 72 14 32 8 60 133.32 
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DMT 1920x1080 @60Hz (DMT 

0x52) 
129 1920 1080 2200 1125 192 41 44 5 60 148.50 

CTA 1920x1080 @60Hz (VIC 16) 130 1920 1080 2200 1125 192 41 44 5 60 148.50 

CVT 1920x1080 @120Hz 131 1920 1080 2080 1144 112 61 32 5 120 285.54 

CVT 1920x1080 @120Hz 132 1920 1080 2000 1144 72 14 32 8 120 274.56 

CTA 1920x1080 @120Hz (VIC 63) 133 1920 1080 2200 1125 192 41 44 5 120 297.00 

CTA 1920x1080 @48Hz (VIC 111) 134 1920 1080 2750 1125 192 41 44 5 48 148.50 

CTA 1920x1080 @48Hz (VIC 112) 135 1920 1080 2750 1125 192 41 44 5 48 148.50 

CVT 1920x1080 @85Hz 136 1920 1080 2624 1137 560 54 208 5 85 253.25 

DMT 1920x1200 @60Hz (DMT 

0x45) 
137 1920 1200 2592 1245 536 42 200 6 60 193.62 

OVT 1920x1440 @60Hz 138 1920 1440 2048 1500 64 36 32 8 60 184.32 

DMT 1920x1440 @60Hz (DMT 

0x49) 
139 1920 1440 2600 1500 552 59 208 3 60 234.00 

CVT 1920x1440 @60Hz 140 1920 1440 2080 1481 112 38 32 4 60 184.75 

CVT 2048x1280 @60Hz 141 2048 1280 2208 1317 112 34 32 6 60 174.25 

OVT 2048x1280 @60Hz 142 2048 1280 2200 1320 64 32 32 8 60 174.24 

OVT 2048x1536 @60Hz 143 2048 1536 2200 1580 64 38 32 8 60 208.56 

CVT 2048x1536 @60Hz 144 2048 1536 2208 1580 112 41 32 4 60 209.32 

CVT 2128x1200 @60Hz 145 2128 1200 2864 1245 592 42 224 10 60 213.75 

OVT 2128x1200 @60Hz 146 2128 1200 2280 1240 64 30 32 8 60 169.63 

OVT 2456x1536 @50Hz 147 2456 1536 2600 1896 64 354 32 8 50 246.48 

OVT 2456x1536 @75Hz 148 2456 1536 2560 2608 64 1057 32 8 75 500.74 

CVT 2456x1536 @50Hz 149 2456 1536 3320 1583 696 44 264 10 50 262.78 

CVT 2456x1536 @75Hz 150 2456 1536 3384 1606 728 67 264 10 75 407.25 

CTA 2560x1080 @24Hz (VIC 86) 151 2560 1080 3750 1100 192 16 44 5 24 99.00 

CTA 2560x1080 @25Hz (VIC 87) 152 2560 1080 3200 1125 192 41 44 5 25 90.00 

CTA 2560x1080 @30Hz (VIC 88) 153 2560 1080 3520 1125 192 41 44 5 30 118.80 

CTA 2560x1080 @50Hz (VIC 89) 154 2560 1080 3300 1125 192 41 44 5 50 185.62 

CTA 2560x1080 @100Hz (VIC 91) 155 2560 1080 2970 1250 192 166 44 5 100 371.25 

OVT 2560x1080 @30Hz 156 2560 1080 2784 1100 64 14 32 8 30 91.87 

OVT 2560x1080 @60Hz 157 2560 1080 2720 1120 64 27 32 8 60 182.78 

OVT 2560x1080 @120Hz 158 2560 1080 2656 1150 64 56 32 8 120 366.53 

CVT 2560x1440 @60Hz 159 2560 1440 2640 1481 72 14 32 8 60 234.59 

CVT 2560x1440 @60Hz 160 2560 1440 2720 1481 112 38 32 5 60 241.70 

CVT 2560x1440 @144Hz 161 2560 1440 2720 1543 152 14 32 8 144 604.57 

CVT 2560x1440 @200Hz 162 2560 1440 2720 1586 152 14 32 8 200 863.09 

CTA 2560x1080 @48Hz (VIC 113) 163 2560 1080 3750 1100 192 16 44 5 48 198.00 

CVT 2560x1080 @60Hz 164 2560 1080 3424 1120 704 37 272 10 60 230.09 

CVT 2560x1080 @60Hz 165 2560 1080 2720 1111 112 28 32 10 60 181.32 

CVT 2560x1080 @144Hz 166 2560 1080 2720 1157 152 14 32 8 144 453.33 

CVT 2560x1080 @200Hz 167 2560 1080 2720 1190 152 14 32 8 200 647.59 

CTA 2560x1080 @60Hz (VIC 90) 168 2560 1080 3000 1100 192 16 44 5 60 198.00 

CTA 2560x1080 @120Hz (VIC 92) 169 2560 1080 3300 1250 192 166 44 5 120 495.00 

DMT 2560x1600 @60Hz (DMT 

0x4D) 
170 2560 1600 3504 1658 752 55 280 6 60 348.58 

DMT 2560x1600 @60Hz (DMT 

0x4C) 
171 2560 1600 2720 1646 112 43 32 6 60 268.63 
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OVT 2560x1600 @60Hz 172 2560 1600 2680 1660 64 40 32 8 60 266.93 

CVT 2560x1920 @75Hz 173 2560 1920 3552 2006 776 83 280 4 75 534.25 

OVT 2560x1920 @75Hz 174 2560 1920 2688 3280 64 1329 32 8 75 661.25 

OVT 2728x1536 @60Hz 175 2728 1536 2880 1580 64 38 32 8 60 273.02 

CVT 2728x1536 @60Hz 176 2728 1536 3720 1592 792 53 296 10 60 355.00 

CTA 2880x240 @60Hz (VIC 12) 177 2880 240 3432 263 476 18 248 3 60 54.00 

CTA 2880x240 @60Hz (VIC 13) 178 2880 240 3432 263 476 18 248 3 60 54.00 

CTA 2880x288 @50Hz (VIC 27) 179 2880 288 3456 314 528 22 252 3 50 54.00 

CTA 2880x288 @50Hz (VIC 28) 180 2880 288 3456 314 528 22 252 3 50 54.00 

CTA 2880x480 @60Hz (VIC 10) 181 2880 480 3432 525 476 18 248 3 60 108.00 

CTA 2880x480 @60Hz (VIC 11) 182 2880 480 3432 525 476 18 248 3 60 108.00 

CTA 2880x480 @60Hz (VIC 35) 183 2880 480 3432 525 488 36 248 6 60 108.00 

CTA 2880x480 @60Hz (VIC 36) 184 2880 480 3432 525 488 36 248 6 60 108.00 

CTA 2880x576 @50Hz (VIC 37) 185 2880 576 3456 625 528 44 256 5 50 108.00 

CTA 2880x576 @50Hz (VIC 38) 186 2880 576 3456 625 528 44 256 5 50 108.00 

CTA 2880x576 @50Hz (VIC 25) 187 2880 576 3456 625 528 22 252 3 50 108.00 

CTA 2880x576 @50Hz (VIC 26) 188 2880 576 3456 625 528 22 252 3 50 108.00 

2880x1440 @60Hz 189 2880 1440 2976 1456 48 8 8 1 60 259.98 

CVT 3440x1440 @60Hz 190 3440 1440 4688 1493 992 50 368 10 60 419.95 

CVT 3440x1440 @60Hz 191 3440 1440 3600 1481 112 38 32 10 60 319.90 

CVT 3440x1440 @60Hz 192 3440 1440 3520 1481 72 14 32 8 60 312.79 

CVT 3440x1440 @120Hz 193 3440 1440 4800 1545 1064 102 384 10 120 889.92 

CVT 3440x1440 @120Hz 194 3440 1440 3600 1525 112 82 32 10 120 658.80 

CVT 3440x1440 @120Hz 195 3440 1440 3520 1525 72 14 32 8 120 644.16 

CVT 3440x1440 @165Hz 196 3440 1440 4832 1588 1080 145 384 10 165 1266.08 

CVT 3440x1440 @165Hz 197 3440 1440 3600 1559 112 116 32 10 165 926.05 

CVT 3440x1440 @165Hz 198 3440 1440 3520 1559 72 14 32 8 165 905.47 

CVT 3440x1440 @200Hz 199 3440 1440 4848 1622 1088 179 384 10 200 1572.69 

CVT 3440x1440 @200Hz 200 3440 1440 3600 1586 112 143 32 10 200 1141.92 

CVT 3440x1440 @200Hz 201 3440 1440 3520 1586 72 14 32 8 200 1116.54 

CVT 3440x1440 @240Hz 202 3440 1440 4848 1663 1088 220 384 10 240 1934.93 

CVT 3440x1440 @240Hz 203 3440 1440 3600 1619 112 176 32 10 240 1398.82 

CVT 3440x1440 @240Hz 204 3440 1440 3520 1619 72 14 32 8 240 1367.73 

CVT 3840x2160 @30Hz 205 3840 2160 4000 2191 112 28 32 5 30 262.92 

CVT 3840x2160 @30Hz 206 3840 2160 3920 2191 72 14 32 8 30 257.66 

CVT 3840x2160 @60Hz 207 3840 2160 4000 2222 112 59 32 5 60 533.28 

CVT 3840x2160 @60Hz 208 3840 2160 3920 2222 72 14 32 8 60 522.61 

CVT 3840x2160 @60Hz 209 3840 2160 4000 2222 152 14 32 8 60 533.47 

CTA 3840x2160 @60Hz (VIC 97) 210 3840 2160 4400 2250 384 82 88 10 60 594.00 

CTA 3840x2160 @24Hz (VIC 93) 211 3840 2160 5500 2250 384 82 88 10 24 297.00 

CTA 3840x2160 @25Hz (VIC 94) 212 3840 2160 5280 2250 384 82 88 10 25 297.00 

CTA 3840x2160 @30Hz (VIC 95) 213 3840 2160 4400 2250 384 82 88 10 30 297.00 

CTA 3840x2160 @50Hz (VIC 96) 214 3840 2160 5280 2250 384 82 88 10 50 594.00 

CTA 3840x2160 @24Hz (VIC 103) 215 3840 2160 5500 2250 384 82 88 10 24 297.00 

CTA 3840x2160 @25Hz (VIC 104) 216 3840 2160 5280 2250 384 82 88 10 25 297.00 

CTA 3840x2160 @30Hz (VIC 105) 217 3840 2160 4400 2250 384 82 88 10 30 297.00 
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CTA 3840x2160 @50Hz (VIC 106) 218 3840 2160 5280 2250 384 82 88 10 50 594.00 

CTA 3840x2160 @60Hz (VIC 107) 219 3840 2160 4400 2250 384 82 88 10 60 594.00 

CTA 3840x2160 @48Hz (VIC 114) 220 3840 2160 5500 2250 384 82 88 10 48 594.00 

CTA 3840x2160 @48Hz (VIC 116) 221 3840 2160 5500 2250 384 82 88 10 48 594.00 

CTA 3840x2160 @100Hz (VIC 117) 222 3840 2160 5280 2250 384 82 88 10 100 1188.00 

CTA 3840x2160 @100Hz (VIC 119) 223 3840 2160 5280 2250 384 82 88 10 100 1188.00 

CTA 3840x2160 @120Hz (VIC 120) 224 3840 2160 4400 2250 384 82 88 10 120 1188.00 

OVT 3840x2160 @30Hz 225 3840 2160 3968 2200 64 27 32 8 30 261.89 

OVT 3840x2160 @60Hz 226 3840 2160 3960 2240 64 54 32 8 60 532.22 

OVT 3840x2160 @120Hz 227 3840 2160 3968 2300 64 111 32 8 120 1095.17 

OVT 3840x2160 @144Hz 228 3840 2160 4000 2314 64 134 32 8 144 1332.86 

OVT 3840x2400 @60Hz 229 3840 2400 3960 2480 64 60 32 8 60 589.25 

OVT 4096x2160 @30Hz 230 4096 2160 4224 2200 64 27 32 8 30 278.78 

CVT 4096x2160 @60Hz 231 4096 2160 4176 2222 72 14 32 8 60 556.74 

CVT 4096x2160 @60Hz 232 4096 2160 4256 2222 112 59 32 10 60 567.41 

CVT 4096x2160 @60Hz 233 4096 2160 4256 2222 152 14 32 8 60 567.61 

CVT 4096x2160 @144Hz 234 4096 2160 4256 2314 152 14 32 8 144 1418.66 

CTA 4096x2160 @60Hz (VIC 102) 235 4096 2160 4400 2250 216 82 88 10 60 594.00 

CTA 4096x2160 @120Hz (VIC 219) 236 4096 2160 4400 2250 216 82 88 10 120 1188.00 

CTA 4096x2160 @100Hz (VIC 218) 237 4096 2160 5280 2250 384 82 88 10 100 1188.00 

CTA 4096x2160 @50Hz (VIC 101) 238 4096 2160 5280 2250 216 82 88 10 50 594.00 

CTA 4096x2160 @48Hz (VIC 115) 239 4096 2160 5500 2250 384 82 88 10 48 594.00 

CTA 4096x2160 @24Hz (VIC 98) 240 4096 2160 5500 2250 384 82 88 10 24 297.00 

CTA 4096x2160 @25Hz (VIC 99) 241 4096 2160 5280 2250 216 82 88 10 25 297.00 

CTA 4096x2160 @30Hz (VIC 100) 242 4096 2160 4400 2250 216 82 88 10 30 297.00 

 

*) TSI Timing ID 

CVT: Coordinated Video Timings (CVT; VESA-2013-3 v1. 2); DMT: VESA and Industry Standards and Guidelines for 

Computer Display Monitor Timings; CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H);  

UG: Unigraf proprietary timing 
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APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 
Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Black 

 

0% luminance 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

Gradient RGB Stripes 

 

16 pixels high horizontal red, green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(step = cs*color_depth/256). “n” range 0 to 5000 (default 100). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 
Selection Icon Description 

Select Image 
 

Custom image uploaded by the user. Click on Select … to browse. 

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 cross-hatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (contd.) 
Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (contd.) 
Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

White 16 x12 Grid on Black background 

X-HatchW-C 
 

White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

China 5.6 White Window 10% 

Gray Box 20 

 

China 5.6 White Window 20% 

Gray Box 30 

 

China 5.6 White Window 30% 

Gray Box 40 

 

China 5.6 White Window 40% 

Gray Box 50 

 

China 5.6 White Window 50% 

Gray Box 60 

 

China 5.6 White Window 60% 

Gray Box 70 

 

China 5.6 White Window 70% 

Gray Box 80 

 

China 5.6 White Window 80% 

Gray Box 90 

 

China 5.6 White Window 90% 

Gray Box 100 

 

China 5.6 White Window 100% 

8 Level Gray 

 

China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (contd.) 
Selection Icon Description 

Black'n'White Window 

HDTV 
 

China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

China 5.10 Black Line 

Black Line SDTV 

 

China 5.10 Black Line SDTV 

Black Window 

 

China 5.7 Black Window 

Check Board 
 

China 5.9 Check Board 

Line'n'Window 

 

China 5.11 Line and Window 

Narrow White Window 

 

China 5.19 Narrow White Window 

Single Dot 

 

China Single Dot 

White Line HDTV 

 

5.10 White Line for HDTV 

White Line SDTV 

 

5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/ downloads/testpatterns.html. 

http://www.icdm-sid.org/
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APPENDIX E: SINK AND SOURCE DUT TESTS 

Source DUT Testing 
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HDCP 2.3 CTS 1A Test Set DP RX 

(UCD-301, UCD-323) 
HCDP2.3 CTS 1A-01 – HCDP2.3 CTS 1A-12  ●  

HDCP 2.3 CTS 1B Test Set DP RX 

(UCD-301, UCD-323) 
HCDP2.3 CTS 1B-01 – HCDP2.3 CTS 1B-10  ●  

Audio Test Set  

(UCD-301, UCD-323) 

Validate audio signal frequency and glitch-free audio 

reproduction 
●   

CEC functional Test Set HDMI RX 

(UCD-301, UCD-323) 

CEC functional test, CEC PHY Addr test,  

CEC Complete test, CEC Wake up test,  

CEC Standby test 

●   

CRC based Video Test Set 

(UCD-301, UCD-323) 

CRC based single frame reference video test;  

CRC based single frame stability test; 

CRC based sequence of frames reference video test  

●   

Timings Video Tests Timings: single reference frame video test ●   

Electrical Test Set HDMI RX 

(UCD-301) 
Power test; TMDS test; HPD test; DDC and CEC test    ● 

Electrical Test Set DP RX 

(UCD-301) 
HPD test; Main Link test; AUX test    ● 

Link Config Tests 

(UCD-301, UCD-323) 
Link Training at All Supported Lane Counts and Link Rates ●   

Pixel Level Video Tests 

(UCD-301, UCD-323) 

Compare a defined number of captured frames to a single 

reference frame 
●   

VRR Source DUT Tests (HDMI RX) 

(UCD-323, UCD-301) 
VRR static test; QMS Test; VRR Dynamic test ●   

*) Separate licenses for testing Sink and Source DUT 

 

Sink DUT Testing 
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HDCP 2.3 CTS 2C Test Set DP TX 

(UCD-323) 
HCDP2.3 CTS 2C-01 – HCDP2.3 CTS 2C-06  ●  

VRR Sink DUT Tests (HDMI TX) 

(UCD-323) 
VRR static test; QMS Test; VRR Dynamic test ●   

*) Separate licenses for testing Sink and Source DUT 
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Test Report 
Results of the test can be saved as a report in HTML format. The report file can be viewed 

with any HTML browser. The report has built-in views for Report Summary, Test Summary, 

and individual Test Logs. 

The user can add details of the DUT, test situation and other remarks to the report. 
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Audio Test Set – DP Rx, HDMI Rx 
Role: Product: 

DP Reference Sink (DP RX) UCD-301, UCD-323, UCD-323 Gen2 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323, UCD-323 Gen2 

 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. 

This test assumes that a pure sine-wave audio signal content is being transmitted to the test 

equipment. 

The test will first capture minimum of one second of audio content. The audio is then analyzed 

in two stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined 

window. Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or 

duplicated samples.  

The test is considered passed if power of audio content spectrum has its maximum within the 

defined window, and the number of detected audio glitches does not exceed programmed 

limit. 

Parameters in use 

• Expected sampling rate of audio signal (default 44 100 s/sec) 

• Expected audible (sine) frequency in Hz (default 1000 Hz) 

• Allowed deviation from expected frequency in Hz (default 1 Hz) 

• The percentage deviation from the ideal sine (default 5) 

• Number of audio glitches allowed per test (default 0) 

• Tested audio save conditions: save none, save failed, save all (default Save none) 

• Location where the captured audio is to be saved. Double click the select folder. (default 

0) 
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CEC Functional Test Set – HDMI Rx 
Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323 

 

Parameters in use 

• Test timeout, in milliseconds 

• Local CEC physical address 

•  

 

CEC Functional Test 

Test is intended to check that DUT does CEC initialization correctly after HPD. TE initialize 

EDID with configured address. Apply HPD and expected that Logical Physical addresses that 

presented in EDID will be applied with Report Physical Address message to inform TE about 

the mapping Logical and Physical addresses. That is expectation of CEC behavior. 

CEC Phy Address test. 
Test is intended to check that CEC line is working properly, and DUT can receive CEC Report 

Physical Address or customized OP Code. TE checks that HPD is high and CEC line available 

and send Report Physical Address (or customized OP Code) message in broadcast mode (or 

with specific destination). 

CEC Wake Up test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Wake Up 

command. TE checks that HPD is high and CEC line available and wait for Wake Up message. 

CEC Stand By test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Stand By 

command. TE checks that HPD is high and CEC line available and wait for Stand By message. 

CEC Complete test 

Test is intended to check that CEC line is working properly, and DUT can send sequence of 

commands from Stand By mode. TE checks that HPD is high and CEC line available. TE 

waiting for sequence of commands from DUT Wake UP and then again Stand By. 

 

Note: The default physical address in UCD EDID is 1:0:0:0. In order to simulate a change in the 

address, please use another address range 

 

Note: As a side effect, the CEC will also verify functionality of HPD and EDID reading if the test 

passes. 
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CRC Video Tests – HDMI Rx, DP Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323, UCD-323 Gen2 

DP Reference Sink (DP RX) UCD-301, UCD-323, UCD-323 Gen2 

Test timeout: 
If enabled test will abort when the time 

has elapsed 

Repeat until timeout: Enable “Test timeout” 

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): 
Number of failing frames allowed before 

test is Fails 

Repeat “Sequence test” until timeout: 
Repeat test sequence until the timeout 

set 

“Sequence test” lenght (# of repeats): Repeat the sequence 

Expected video format 
Format of the signal expected. Width, 

heiht and reference BPP. 

Expected frame rate 
Expected frame rate and frame rate 

tolerance. 

Number of captured reference  Number of frames stored as reference 

Capture Reference Frames Capture reference frames for the test 

Folder to save failed frames: 
PC folder where failed frames are 

stored. 

Maximum number of save frames: 
Maximum number of failed frames 

stored to PC 

Format of saved frames Select the format of saved frames 

Presets: Store and recall settings 
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CRC Based Single Reference Frame Video Test 

The test compares captured frames to a provided reference. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to 

provided parameters and after that captures frames and compares the CRC (check sum) of 

their three color components to the provided reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is 

exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Test lengths (default 200 frames) 

• Errors allowed (default 20) 

• Sequence test length (default 1) 

• Expected video format 

o Width (default 1920) 

o Height (default 1080) 

o Reference BPP (default 24) 

• Expected frame rate 

• Frame rate tolerance  

CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE 

captures frames and compares their CRC (check sum) to the reference until the number of 

bad frame limit provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Test lengths (default 200 frames) 

• Errors allowed (default 20) 
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CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to 

provided parameters. After that captures frames to find a frame with matching CRC (check 

sum) of their three color components to the first provided reference. After the first matching 

CRC is found it compares the CRC of the following frames until the Number of frames tested 

parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or 

the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Test lengths (default 200 frames) 

• Expected video format 

o Width (default 1920) 

o Height (default 1080) 

o Reference BPP (default 24) 

• Expected frame rate 

• Frame rate tolerance  

 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame 

list should be different. 

CRC Based Continuous Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color 

format) to provided parameters. After that captures frames to find a frame with matching CRC 

(check sum) of their three color components to the first provided reference. After the first 

matching CRC is found it compares the CRC of the following frames until the Number of frames 

tested parameter is reached. After that it resets the list and starts from the first CRC. The list 

is repeated until timeout or until the provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or 

the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard 

disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Test lengths (default 200 frames) 

• Errors allowed (default 20) 

• Sequence test length (default 1) 

• Expected video format 

o Width (default 1920) 

o Height (default 1080) 

o Reference BPP (default 24) 

• Expected frame rate 

• Frame rate tolerance  

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame 

list should be different. 
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Timings Video Tests – HDMI Rx 

 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323, UCD-323 Gen2 

Test timeout: 
If enabled test will abort when the time 

has elapsed 

Repeat until timeout: Enable “Test timeout” 

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): 
Number of failing frames allowed before 

test is Fails 

Expected video format 

Format of the signal expected: 

Reference BPP, HTotal, VTotal, HACtive, 

VActive, HFront, VFront, HSync, VSync 

Capture Reference Frames Capture reference frames for the test 

Expected frame rate 
Expected frame rate and frame rate 

tolerance. 

Folder to save failed frames: 
PC folder where failed frames are 

stored. 

Presets: Store and recall settings 
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Electrical Test Set – HDMI Rx  
Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301 

Electrical Tests verify the continuity of the interface signals and the voltage levels applied by 

the driving electronics. 

Power Test 

Power Test verifies the voltage level on the +5 V power line (Pin 18) of the DUT source. The 

accepted value in HDMI specification is 4.7 V to 5.3 V on the sink side connector. (Called 

“TP2” in the HDMI specification). 

The test will measure the power line voltage using two loads: 0 mA and 55 mA. The latter is 

the test setup in HDMI CTS specification (HDMI CTS 1.4b: Test ID 7-11: +5V Power). The test 

will fail if voltage level on the power line is below or above the voltage range set by the 

parameters. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Power line low voltage limit (default 4 700 mV) 

• Power line high voltage limit (default 5 300 mV) 
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TMDS Test 

TMDS Test verifies average voltage levels on TMDS signal lines (8 lines: CLK+/-, D0+/- D1+/- 

and D2+/-). The positive and negative lines of the TMDS differential pair are measured 

separately. 

TMDS uses DC balanced signaling. Sink pulls the lines up to 3.3 V (AVcc) and source applies 

the TMDS signal by pulling the line down to ground. On an active TMDS line average voltage 

level is half of the voltage swing below AVcc (AVcc – Vswing/2). By default, 2.6 V to 3.1 V.  

TMDS line voltages outside of the above range might indicate an abnormal situation like short 

circuit of two TMDS lines, short to ground, open circuit or a broken output driver.  

If the measured values fall outside the criteria set by the parameters, test result is FAIL. 

Note: Fail criteria for each test set-up should be considered separately depending on the source 

DUT and test cable configuration. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Main link low voltage limit (default 2 600 mV) 

• Main link high voltage limit (default 3 100 mV) 

HPD Test 

HPD Test verifies HPD line (pin 19) for short circuits to power or ground. 

The test runs in two steps: 

Step 1. HPD line is driven to logical low state and after a delay voltage level is measured. If the 

measured value is outside the limits set by the parameters for “zero” voltage minimum and 

maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 

Step 2. HPD line is driven to logical high state and after a delay voltage level is measured. If 

the measured value is outside the limits set by the parameters for “one” voltage minimum and 

maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending if the measured value is below the allowed window, or above it. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• HPD line logical zero low voltage limit (default -50 mV) 

• HPD line logical zero high voltage limit (default 400 mV) 

• HPD line logical one low voltage limit (default 2 400 mV) 

• HPD line logical one high voltage limit (default 5 300 mV) 

DDC and CEC Test 

DDC and CEC Test verifies voltage level of SCL (pin 15), SDA (pin 15) and CEC (pin 13) lines. 

HPD signal is driven low to de-activate any transmission in the tested lines. After a delay of 

100 ms voltage level is measured in the three signal lines. 

If the measured voltage levels are outside the parameter limits, the test result is FAIL. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• DDC lines low voltage limit (default 4 500 mV) 

• DDC lines high voltage limit (default 5 500 mV) 

• CEC line logical zero low voltage limit (default -50 mV) 

• CEC line logical zero high voltage limit (default 600 mV) 

• CEC line logical one low voltage limit (default 2 500 mV) 

• CEC line logical one low voltage limit (default 3 600 mV) 
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Electrical Test Set – DP Rx 
Role: Product: 

DP Reference Sink (DP RX) UCD-301 

 

Electrical Tests verify the continuity of the interface signals and the voltage levels applied by 

the driving electronics. 

HPD Test 

HPD Test verifies HPD line for short circuits into power or ground lines. 

The test runs in two steps: 

Step 1. HPD line is asserted to logical high state and after a delay voltage level is measured. 

If the measured value is outside the limits set by the parameters for “one” voltage minimum 

and maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending, if the measured value is below the allowed window, or above it. 

Step 2. HPD line is de-asserted to logical low state and after a delay voltage level is measured. 

If the measured value is outside the limits set by the parameters for “zero” voltage minimum 

and maximum the test result is FAIL. The judgement is “Short to ground” or “Short to power” 

depending, if the measured value is below the allowed window, or above it. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• HPD line logical zero low voltage limit (default -100 mV) 

• HPD line logical zero high voltage limit (default 799 mV) 

• HPD line logical one low voltage limit (default 2 000 mV) 

• HPD line logical one high voltage limit (default 3 600 mV) 

 

Main Link Test 

The test utilizes a dedicated microchip to determine the power of DP Main Link input signal. 

The test verifies that the measured values lie within the window defined by provided 

parameters. 

The measured values provide a relative voltage value that depends on the signal waveform 

and selected pre-emphasis and voltage swing. The values do not represent any absolute 

value, e.g., input signal voltage level. 

“No signal” level is initially set to 2.3V. Note that even a disconnected line will give a relatively 

high value. Good signal levels are expected to be within range 2.6 V to 4.0 V. The allowed 

voltage window should be set separately for each device model after testing of several units. 

Measured values are expected to be close to each other within a differential pair. Also, all main 

link differential pair measurements should produce a value close to each other if link training 

result is the same for all pairs. 

Measurement results are given in volt, but this is only the voltage level of power measurement 

circuitry output and does not relate to the actual input signal. The positive and negative lines 

of main link differential pairs are measured separately. 

Note: The measured values provide a relative voltage value that depends on the signal waveform 

and selected pre-emphasis and voltage swing. The values do not represent any absolute 

value, e.g. input signal voltage level. 
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Parameters in use 

• Test Timeout (default 5 000 ms) 

• Main link low voltage limit (default 2 600 mV) 

• Main link high voltage limit (default 4 000 mV) 

• Maximum lanes count supported by DUT (default 0) 

• Maximum data rate supported by DUT in 0.27 Gbps (default 0) 

AUX Test 

The test verifies voltage levels on AUX lines, and AUX connectivity to DUT. 

The test verifies two issues: 

1. The idle AUX voltage level is measured and compared to provided parameters. The voltages 

are expected to match values defined by resistor dividers set by connected DisplayPort sink 

and source devices. 

2. The TE creates a short HPD pulse to have the DUT to generate an AUX request. The DUT 

is expected to read DPCD register address range 0x200 – 0x205. Test captures the sync 

sequence of the AUX transaction and verifies the unit interval timings. 

The test is first done to AUX- line and then to AUX+ line. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• AUX+ line idle low voltage limit (default 2 400 mV) 

• AUX+ line idle high voltage limit (default 3 600 mV) 

• AUX– line idle low voltage limit (default 2 400 mV) 

• AUX– line idle high voltage limit (default 3 600 mV) 

• AUX+ line signal trigger low level (default 150 mV) 

• AUX+ line signal trigger high level (default 200 mV) 

• AUX– line signal trigger low level (default 200 mV) 

• AUX– line signal trigger high level (default 5 mV) 

• AUX signal capture timeout (default 4 ms) 

• AUX signal capture attempts (default 20 times) 
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Link Config Tests – DP Rx 
Role: Product: 

DP Reference Sink (DP RX) UCD-301, UCD-323 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must 

be successfully completed in order to pass the test. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Max lane count supported by DUT (default 4) 

• Max lane rate supported by DUT as multiple of 0.27 Gbps.  

(valid settings 6, 10 and 20; default 20) 

• Long HPD pulse duration (default 1 000 ms) 

• Link training start timeout (default 5 000 ms) 

• Delay between test cycles (default 3 000 ms) 

  



 Appendix E: Sink and Source DUT Tests 

 

UCD-3XX User Manual • UCD Console 3.9 150. 

Pixel Level Video Tests – DP Rx, HDMI Rx 
Role: Product: 

DP Reference Sink (DP RX) UCD-301, UCD-323 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323 

Compare a defined number of captured frames to a single reference frame. 

The test will capture the required number of consecutive frames into system RAM and then 

perform analysis between each frame and reference frame. Test is considered passed if the 

number of failed frames does not exceed the programmed value. 

Parameters in use 

Load image: Load the reference image 

Image resolution (#pixels): width and 

height 

Video resolution expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format align: Video data format expected (MSB, LSB) 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed pixels 

allowed per frame: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Folder to save failed images: PC folder where failed frames are stored. 

Maximum number of exported frames: Maximum number of failed frames stored to PC 

Export format Binary file, PPM image or BMP image 

Presets: Store and recall settings 
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VRR Source DUT Tests – HDMI Rx 
Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301, UCD-323, UCD-323 Gen2 

 

 

Parameters in use 

• Test timeout, in milliseconds 

• VRR Max value – maximum VRR frame rate value; 

• VRR Min value – minimum VRR frame rate value; 

• VRR Static value – static VRR frame rate value; 

• VRR Step value – value to change current VRR value during a test; 

• VRR Time step value – value to change current VRR value during a test; 

• VRR Enable and M_CONST 

• VFront and RB 

• Base Refresh Rate 

Static VRR Test 

Test verifies that DUT Source applies expected static VRR value. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that received timing matches the VRR 

Value parameter and the data in received EMP packets match the timing. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For 

example, change VRR from 30 to 60 Hz with step 1 each 1 second. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that VRR is changed after each time 

interval set by VRR Time parameter, and the applied VRR change is as set in the parameter. 

Test also verifies that data in received EMP packets match with applied VRR. 

VRR Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, 

change VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts 

VRR mode. When VRR mode is detected, test verifies that VRR is changed between each 

frame. Test also verifies that data in received EMP packets match with applied VRR. 
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VRR Sink DUT Tests – HDMI Tx 
Role: Product: 

HDMI Reference Source (HDMI TX) UCD-323 

Parameters in use 

• Test timeout, in milliseconds 

• VRR Max value – maximum VRR frame rate value; 

• VRR Min value – minimum VRR frame rate value; 

• VRR Static value – static VRR frame rate value; 

• VRR Step value – value to change current VRR value during a test; 

• VRR Time step value – value to change current VRR value during a test; 

• VRR Enable and M_CONST 

• VFront and RB 

• Base Refresh Rate 

Static VRR Test 

Test verifies that DUT Sink correctly applies a static VRR value. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has 

applied VRR correctly and provides the information in the dialog of the test. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For 

example, change VRR from 30 to 60 Hz with step 1 each 1 second. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has 

applied VRR correctly and frame rate is changing as expected. Operator provides the 

information in the dialog of the test. 

Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, 

change VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has 

applied VRR correctly and frame rate is changing as expected. Operator provides the 

information in the dialog of the test. 
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APPENDIX F: VPATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible 

way of describing test patterns for UCD Generators. This description is providing an 

introduction and examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. 

The coordinate system can be either absolute or scaled. In the absolute mode the actual pixel 

position is referred while in the scaled mode the coordinates refer to the “Drawing resolution” 

used while drawing. For both absolute and scaling coordinates the origin is the upper left hand 

corner of the screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The 

actual position is always related to the coordinate system currently in use 

Drawing resolution: the width and height of the space that can be used for drawing, expressed 

in pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the 

current coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the 

drawing area includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode 

or x = 0 to 10000 and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a 

generic variable. 

• Different legal choices for a command parameter are separated by character ‘|’. For 

instance, <variable> | <number> means that either variable or number can be used as 

parameters. 

• Items that can be repeated 0, 1 or more times are preceded by ‘{‘ and followed by ‘}*’. 

For instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• The VTP is a text-based, interpreted language 

• Commands, variables, and constant names are not case-sensitive. 

• All text at the right of a semicolon (‘;’) is treated as comment. 

• All strings are delimited by quotation marks (“a string”). Quote and backslash characters 

must be prefixed by the backslash symbols (“ a quote \” and a backslash \\”). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. 

The absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the 

line). It extends up to the maximum drawing resolution in use minus one, expressed in pixels 

too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the 

drawing resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. 

Scaled coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued 

after ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted 

as pixels and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for 

x is 0 to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic 

scaling capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates 

interpreted as within a range from 0 to 10000 (10001 possible coordinate values), regardless 

of the current drawing resolution. Positioning can be calculated as percentages. If you wanted 

to address a point at 50% of the drawing resolution, then you would use the number 5000. If 

you wanted 75% you would simply use the 7500. 

Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color 

for shape perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE and SCALED coordinate mode 

and get the same result. 

ABSOLUTE ; Set scaling mode to absolute 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner  

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 
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The pattern will look like this: 

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed as a vertical measure. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 50 

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note 

that when using SCALED coordinates radius r is expressed as a vertical measure. 

The pattern will look like this: 

ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example when the displayed pixel is not square 

for compensating the stretching. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 
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Text Drawing Commands 

All of the following commands use the currently selected foreground color for the 

“foreground” pixels of the font and the currently selected background color for “background” 

pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> 

}* 

The command executes a CR and LF (carriage return and line feed) and then draws a text 

string <string>, a variable <var>, a constant <const> or a combination of them starting from 

the current text position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character 

(“) or a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

Note: Please note that when using the timing parameters in a pattern the display will be redrawn 

every time the timing is changed. Normally the VTG does not have to redraw the picture when 

only e.g., the horizontal sync is changed, but if the HS variable is used in the pattern it needs 

to be updated to display the new value. 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100 ; Text starting point 100 pixels from left edge and 100 display 

lines down from top 

TEXT “HRES=” HR “ PIXELS ; This will draw the text HRES then the 

variable HR value and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times 

defined by <variable>. <variable> is set to value a before starting the first iteration loop. At the 

end of each iteration, variable is incremented by s (variable = variable + s). The REPEAT is 

terminated when variable reaches or exceeds value b, and the execution continues from the 

command following the END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 

Color Commands 

The user can assign the used colors in two basic ways: either by giving the actual Red, Green 

and Blue (or R, G and B) color component values or using pre-defined color palettes. The first 

method is referred as True Color Mode and the latter as Palette Mode. 

In True Color Mode the numerical values given for R, G and B will be the actual output signal 

intensity values for the pixel in question. The numerical color value in Palette Mode will act as 

an address (or index) to a pre-defined color in a 256 color table. The output signal intensity 

will be the R, G and B value entry in the cell where the address points to. 

Palette mode can only be used with True Color Mode is . 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits 

used for each color component (R, G and B) of the data to be displayed. Possible values for 

the parameter n are 6, 8, 10 and 12. If COLORDEPTH command is not used, 10 bits per color 

is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 
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COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The 

command is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command 

for range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 
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Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 

 

Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax 

below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions have always positive integers or zero value. When an expression evaluates to a 

negative value, it is set automatically to zero. Number values are also always positive integers 

or zero. 
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Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Output image is cleared (all black) 

All variables are initialized to zero 

COLORDEPTH 10 
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APPENDIX H: PLAYLISTS AND SCENARIOS 
UCD Console’s Playback enables you to run scripts called playlists. Use playlists to stream 

video, audio and metadata. 

Playlist 

A Playlist is a text script consisting of a [Device] block and [Scenario] block(s). A [Device] block 

lists the serial number of the device and connectortype (such as a displayport transmitter). 

[Scenarios] blocks have a caption (which are used to display sample content), a period 

(Scenario duration in milliseconds) and a relative path to a script text file (ex. 

Scenario_PSR1_Entry_N.txt). Scenarios are played in sequence.  

Scenario 

A scenario is a script text file to specify a sequence of video frames, metadata packets and 

audio to be transmitted.  

Frame Memory 

When played, all content is first loaded to the frame memory buffer of the UCD device. This 

enables smooth transition between content items during execution of the Scenario.  

The size of frame buffer memory sets a limit for content that can be played. In their default 

configuration UCD devices feature a 2 GBytes frame buffer memory. This frame buffer enables 

loading up to 40 pcs 4K video frames or 10 pcs 8K video frames.  

Also available is UCD-323 HDDP 4G (P/N 066520) with 4 gigabytes of frame buffer memory. 

Sample Content 

UCD Console’s Playback tab features a set of sample content. These examples can be used 

as a basis for creating custom test sequences. The sample content is stored as files by default 

in C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. It is advisable to 

create copy of the installed original files and edit the copies. 

See Sample Content later in this Appendix. 
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Playlists 

A playlist defines the UCD device to be used and the output destination for transmission. It 

lists scenarios the played (video and audio sequences including metadata) to be transmitted 

and their duration. 

Note: Playlists and Scenarios are technology dependent. Metadata (or packets) differ for HDMI and 

DisplayPort Device section  

Device block 

Device block describes the device and output connector type. 

Key  Description  Possible values  

[Device] Required. Start of the Device block.  

serialnumber  Required. Specifies serial number of the UCD device.  

The ‘*’ wildcard can be used if only one UCD source 

device is connected to the PC.  

‘*’  

‘1722C333’  

connectortype  Required. Specifies output connector to be used. 

Playlist cannot contain scenarios for different 

connector types.  

‘HDMI Out’  

‘DisplayPort Out’  

‘USBC Out’  

reset  Optional. ‘1’ = UCD device is restarted after playlist 

completion Device restart takes approximately up to 5 

seconds.  

Only for use with UCD-323. 

‘0’ or ‘1’ 

Default ‘0’ 

 

Scenario block  

Section describes selected scenario and its playback parameters. Playlist runs scenarios in 

the order they are listed. 

Key  Description  Possible values  

[Scenario] Required. Start of a Scenario section. Playlist can 

have multiple Scenario sections. 

 

caption  

 

Optional. Title of the Scenario. Any character string 

accepted.  

‘Scenario 1’  

‘Playlist 

completed’  

path  Required. Specifies relative path to scenario file.  Any path  

period  Required. Duration of Scenario in msec. The duration 

is ignored if close-after-upload is set to ‘1’.  

‘60000’  

‘5000’  

close-after-upload  Optional. When set to ‘1’, command line version of 

the Playback tool will exit after loading scenario 

content and starting playback.  

‘0’ or ‘1’  

Default ‘0’ 

execute-after-upload  

 

Optional. Executes provided command in cmd.exe or 

bash and waits for its completion. Calculation of 

‘period’ starts after the command is executed. 

‘script.bat && dir’  

‘rmdir 

/home/user/test/’  
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Scenarios 

A Scenario is text file for specifying a specific sequence of video frames, events (packets) and 

audio to be played in order. Scenarios also set up the device state for transmission. 

Parameters 
Scenario parameters are defined below. 

Scenario ite Description 

video   Relative path format of video frame files 

audio Relative path of the audio file 

packets  Relative path of metadata packet files 

porder Play order. See Content Playing Order below. 

align12 
Alignment of 12-bit binary pixel data. ‘1’ aligned to 

LSB; ‘0’ aligned to MSB. 

audioswap ‘1’ for Little Endian audio samples 

audiocompressed 1 compressed audio; 0 uncompressed audio 

audiosampling Audio sampling rate (e.g. 44100) 

audiochannels Number of audio channels 

audiobits Audio bits per sample (usually 16 or 24) 

scramble 1 scrambling enabled; 0 scrambling disabled 

colorspace Video color space: RGB; YUV444; YUV422; YUV420 

bitspercolor Video color depth (bits per color) 

timing.hactiv Timing: horizontal active 

timing.vactiv Timing: vertical active 

timing.htota Timing: horizontal total 

timing.vtotal Timing: vertical total 

timing.hstart Timing: horizontal start 

timing.vstart Timing: vertical start 

timing.hsync Timing: horizontal sync width 

timing.vsyn Timing: vertical sync width 

timing.frate Timing: framerate in milliseconds 

hdcp HDCP version used (can be 1.4 2.3 or ‘none’) 

loadingRGB 

The R, G and B color components of uniform color 

pattern shown when content is being uploaded to 

the device before playback (e.g.0,0,0) 
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Content Play Order 

Play order is a sequence of steps. Steps are delimited with semicolons (;).  

Each step has:  

Range (possibly numbered e.g. allm_000.jpg, allm_001.jpg, …) of video frame(s)  

How many times the frame(s) are played 

Packet(s) (possibly numbered e.g. allm_0.bin, allm_1.bin, …) indices to be sent during 

the video frame(s) transmission  

Color format 

Optional frame rate when VRR/Adaptive-Sync is enabled 

Format 

Each scenario step is described in the form:  

pV:R:E:FvXX; 

Parameters  

Сhar  Description  Possible 

values  

Examples  

:  Required. Separator between general step parameters.  ‘:’  See any below  

;  Required. Indication of step description end.  ‘;’  See any below  

p  Optional. Indicates assertion of a HPD pulse on  

HDMI RX connector of UCD device during current step.  

Preceding video frame index. Only for HDMI playback.  

‘p’  ‘p1:60:1:256;’  

‘p0-59:60:1:256;’  

V  Required. Index (zero based) of video frame. Images 

are loaded from the video file path. Specifies a range of 

image(s). The order in which images are called in a 

scenario is optional. Specified parameters are applied to 

all frames in the step 

‘1’  

‘0-59’  

‘1:60:16:256;’ 

 ‘0-59:60:16:256;’  

R  Required. Repetitions of current step.  

E.g., stating ‘1’ with 60 FPS frame rate means that 

current step will be played only for 1/60 of a second.  

‘30’  

‘1’  

‘1:30:16:256;’  

‘1:1:16:256;’  

E  Optional. Metadata packet indices (zero based): A single 

packet or a comma separated list of packets. 

The index may be of the form 3l15 (lower case ‘l’).   

At which vertical line do we want to put our packet in. 

3l15 means insert packet 3 at line 15. 

Packets are loaded from the packets path. 

‘0’  

‘4,1,29’  

none 

3l15  

‘1:30:0:256;’  

‘1:30:4,1,29:256;’  

‘1:30::256;’ 

0:10000:3l15:256; 

  

F  Required. Color Format and color depth.  

See Color Format below.  

‘256’  

‘513’  

‘1:30:0:256;’ 

‘1:30:0:513;’  

vXX  Optional. Control of frame rate when VRR/Adaptive-Sync 

is enabled. In order to enable VRR/Adaptive-Sync, the 

corresponding event must be included in this step.  

The parameter is always in format of ‘vXX’, where ‘XX’ 

states frame rate. The parameter is provided after color 

format value, separated with ‘v’.  

‘v60’  

‘v30’  

‘1:30:0:256v60;’  

‘1:30:0:256v30;’  
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Color Format  

Color format is a two-byte decimal value: The lower byte is the index to the color space and 

the higher byte the index to the color depth. See below. 

Index Color Depth  

(bits/color) 

Color Space 

0 6 RGB 

1 8 YCbCr 4:4:4 

2 10 YCbCr 4:2:2 

3 12 YCbCr 4:2:0 

4 16 – 

 

The encoded parameter value is encoded as follows:  

[Color Depth] × 256 + [Color Space],  

where [Color Depth] and [Color Space] are indices from the table above. 

For example, parameter for YCbCr 4:4:4, 10 bits is ( 2 × 256 + 1 ) = 513.  

Pre-calculated values for available color formats are shown below: 

 6 BPC 8 BPC 10 BPC 12 BPC 16 BPC 

RGB  0 256 512 768 1024 

YCbCr 4:4:4  N/A 257 513 769 1025 

YCbCr 4:2:2  N/A 258 514 770 1026 

YCbCr 4:2:0  N/A 259 515 771 1027 
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Example 
Please find below description of Playlist SDR-HDR-HLG – HDMI. 

Playlist file (Playlist SDR-HDR-HLG - HDMI.txt) 

Playlist item and example content Description 

[Device] Start of device section 

serialnumber=* Only one UCD device present. 

connectortype=HDMI Out HDMI output 

[Scenario] Start of Scenario 1 

caption = SDR Scenario title “SDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR_HDMI.txt Scenario file: Scenario_SDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 2 

caption = HDR Scenario title “HDR” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_HDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 3 

caption = HLG Scenario title “HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HLG_HDMI.txt Scenario file: Scenario_HLG_HDMI.txt in current folder 

[Scenario] Start of Scenario 4 

caption = SDR – HDR Scenario title “SDR – HDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR-HDR_HDMI.txt Scenario file: Scenario_SDR-HDR_HDMI.txt in current 

folder 

[Scenario] Start of Scenario 5 

caption = SDR – HLG Scenario title “SDR – HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_SDR-HLG_HDMI.txt in current 

folder 
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Scenario File (Scenario_SDR-HDR-HDMI.txt) 

Scenario item and example content Description 

video=goldenGate0.jpg Video files in current folder, file name format 

goldenGate0.jpg (0…) 

audio=<Audio not selected> Audio not selected 

packets=HDMI\Infoframes_0000.bin Packet files in folder HDMI\, file name format 

Infoframes_0000.bin (0…) 

porder=0:180:2:256;1:180:2,0:256; 180 frames of image index 0, Packet index 2, RGB 8 bpc 

180 frames of image index 1, Packets index 2 and 0, 

RGB 8 bpc 

align12=1 Pixel data is aligned to LSB 

audioswap=0 - 

audiocompressed=0 - 

audiosampling=0 - 

audiochannels=0 - 

audiobits=0 - 

scrambler=0 scrambling disabled 

colorspace=RGB444 Video color space: RGB 4:4:4 

bitspercolor=8 Video color depth: 8 (bpc) 

timing.hactive=1920 Timing: Horizontal active 

timing.vactive=1080 Timing: Vertical active 

timing.htotal=2200 Timing: Horizontal total 

timing.vtotal=1125 Timing: Vertical total 

timing.hstart=192 Timing: Horizontal start 

timing.vstart=41 Timing: Vertical start 

timing.hsync=44 Timing: Horizontal sync width 

timing.vsync=5 Timing: Vertical sync width 

timing.frate=60000 Timing: Frame rate 60 fps 

hdcp=none HDCP not enabled 

loadingRGB=52,127,150 Solid color pattern shown when content is being 

uploaded to the device before playback is R=52, G=127, 

B=150. (Sample:  ) 
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Sample Content in Playback Tab 

UCD Console’s Playback tab features a set of examples for the user to create custom test 

content. This content is stored by default in C:\Program Files\Unigraf\Unigraf UCD Tools 

\data\playback\content. It is advisable to create copy of the installed files and edit the copies. 

Note: Playlists and Scenarios are interface technology dependent.  

The provided examples are different for HDMI and DisplayPort. 

Provided examples for each interface are shown below: 

HDMI 
The following playlists are available for HDMI interface. 

 Playlist Name Description Location 

Basic Video & 

Audio Example 

Example playlist for demonstrating the 

use of video and audio files. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Basic 

VRR Example 

Playlist for demonstrating Variable 

Refresh Rate (VRR) capability of a DUT 

monitor. 

Utilizes extensively frame sequencing 

capability in scenario, and the use of 

metadata packets. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

QMS-VRR 

Example 

Playlist for demonstrating Quick Media 

Switching - Variable Refresh Rate 

(QMS-VRR) capability of a DUT 

monitor. Utilizes extensively frame 

sequencing capability in scenario, and 

the use of metadata packets. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

ALLM  

Playlist for demonstrating Auto Low-

latency Mode (ALLM) capability of a 

DUT monitor. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\ALLM 

Audio-Video 

Latency 

These scenarios can be used to 

estimate audio-video synchronization 

using external tools like Sync-One2 or 

similar. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\AV Latency 

HDR & Metadata 

Example 

Example playlist that demonstrates the 

use of video files and metadata packets 

in testing a DUT monitor 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\HDR 

GoldenGate 

Grayscale 

The scenarios show smooth transition 

though shades of gray from black to 

white. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Grayscale 

HDR10+ SSTM & 

SBTM Example 

Playlist demonstrates using HDR10+ 

SSTM VSIF for Source-Side Tone 

Mapping, and HDMI Forum SBTM VSIF 

for Source-Based Tone Mapping. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\SBTM-

SSTM 

Dolby Vision 

DEMO – Playlist  

A set of static images transmitted with 

matching Dolby Vision metadata. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Dolby 

Vision 
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DP 
The following playlists are available for DisplayPort interface. 

Playlist Name Description Location 

Basic Video & Audio Example 

Example playlist for 

demonstrating the use of video 

and audio files. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Basic 

Frame Rate Example 

Playlist for demonstrating use 

of multiple frame rates with 

FHD and UHD resolution. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

Audio-Video Latency 

These scenarios can be used 

to estimate audio-video 

synchronization using external 

tools like Sync-One2 or similar. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\AV 

Latency 

HDR & Metadata Example 

Example playlist that 

demonstrates the use of video 

files and metadata packets in 

testing a DUT monitor 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\HDR 

Golden Gate 

Grayscale 

The scenarios show smooth 

transition though shades of 

gray from black to white. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Grayscale 

HDR10+ SSTM Example 

Playlist demonstrates using 

HDR10+ SSTM VSIF for 

Source-Side Tone Mapping. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\SBTM-

SSTM 

PSR1 

A set of static images 

transmitted with matching 

Dolby Vision metadata. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Panel 

Replay 
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Playlist: Basic Video & Audio Example 
The playlist sequences video files and audio according to the description below. 

Video 

Frames used for Scenario 1 and Scenario 2 (Image1.jpg, Image 2.jpg) 

Frame used for Scenario 3 and Scenario 4 (Philips.svg) 

Description of Scenarios 

 Name Duration Repeated sequence 

1 
Flip-flop with LPCM 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: Rhythm.wav 

2 
Flip-flop with AC3 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: 

44100Hz_16bit_AC3_2channels_60sec_sine.iec61937.bin 

3 Flip-flop Silent 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 frames Image1.jpg, 60 frames Image2.jpg,  

No Audio. 

4 
Philips 1920x1080p + 

1kHz 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 

5 
Philips 3840x2160p + 

1kHz 
60 s 

CTA 3840 x 2160 @ 60Hz (VIC 97), RGB 8 BPC 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 
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Playlist: Audio-Video Latency 

Note: To measure video latency, ULT-01 test tool is needed. 

Description of Scenarios 

These scenarios can be used to estimate audio-video synchronization using external tools like 

Sync-One2 or similar. Video latency measuring requires the Unigraf ULT-01 tool. 

The pattern with a white patch is shown for 15 frames, and then the black screen is shown for 

45 frames. The audio beep is transmitted during the first frame of a white patch pattern. 

 

Video 

Frames used for the scenario (frame1.vpattern frame0.vpattern) 

 

  

  

 Name Duration Repeated sequence 

1 vic16 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

15 frames frame1.vpattern, 45 frame0.vpattern,  

Audio: beep.wav 

2 vic97 60 s 

CTA 3840×2160 60 Hz (VIC 97), RGB 8 BPC,  

45 frames frame1.vpattern, 15 frame0.vpattern,  

Audio: beep.wav 
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Playlist: HDR & Metadata Example 
Example demonstrates the use of metadata packets. 

Video: 

The Scenarios use four versions of the same image: GoldenGate0.jpg, GoldenGate1.jpg, 

GoldenGate2.jpg and GoldenGate3.jpg. 

All four images use the same dynamic range in pixel data but contain a text label indicating 

pixel dynamic range applied in the metadata. If DUT behaves correctly, applying different 

metadata changes the appearance of the image on DUT screen.  

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

SDR 10 sec 180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

HDR 10 sec 
180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

HLG 10 sec 
180 frames GoldenGate2.jpg, Packets: Infoframes_0001, 

Infoframes_0002 

HDR10+ 10 sec 
180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 

SDR – HDR 10 sec 

180 frames GoldenGate0.jpg, Packets: Infoframes_0002; 

180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

SDR – HLG 10 sec 

180 frames GoldenGate0.jpg, Packet: – ; 

180 frames GoldenGate2.jpg, Packets: Packets: Infoframes_0001, 

Infoframes_0002 

SDR – HDR10+ 10 sec 

180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 
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Playlist: Grayscale 

Description of Scenarios 

The scenarios show smooth transition though shades of gray from black to white.  

 Name Duration Repeated sequence 

1 GrayFHD_60 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,  

Audio: No audio 

2 GrayUHD_119 60 s 

CTA 3840×2160 119,88 Hz, RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,   

Audio: No audio 

 

Video 

Below you can see three example frames from the video. 

Gray0.vpattern 

 

Gray60.vpattern 

 

Gray119.vpattern 
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Playlist: Dolby Vision DEMO (HDMI) 

Description of Scenarios 

A set of static images transmitted with matching Dolby Vision metadata. 

 

 Name Duration Repeated sequence 

1 playFiles_scenario 30 s 

1920×1080 60Hz, RGB 8 BPC,  

4 frames: Video_0000.bin – Video_0003.bin, 

Infoframes: Infoframe0000.bin – InfoFrame0033.bin  

Audio: No audio 
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Playlist: VRR Example (HDMI) 
Playlist demonstrates controlling VRR (Variable Refresh Rate) in Scenarios when using HDMI 

output. 

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating 

items. The test uses a sequence of images creating a full rotation in 60 frames. 

Scenario with Video Mode 1920.1080 60 Hz 

The scenario uses 1920×1080 59.94/60 Hz video timing (VIC 16). No audio. 

 Name Duration Repeated sequence 

1 
FHD VRR 48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC. 

Packets: infoframe_00, infoframe_01 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 

 

Scenario with Video Mode 3840.2160 60 Hz 

The scenario uses 3840×2160 59.94/60 video timing (VIC 97). No audio. 

 Name Duration Repeated sequence 

1 
UHD VRR48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC.  

Packets: infoframe_00, infoframe_02 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 

Scenario with Video Mode 3840.2160 60 Hz 

The scenario uses 3840×2160 59.94/60 video timing (VIC 97). No audio. 

 Name Duration Repeated sequence 

1 
UHD VRR48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC.  

Packets: infoframe_00, infoframe_02 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 
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Playlist: QMS-VRR Example (HDMI) 
Playlist demonstrates Quick Media Switching QMS by sending Video Timing Extended 

Metadata (VTEM) with TFR changing between 48/1.001 and 60. 

Video 

The same as in VRR Example above. 
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Playlist: ALLM (HDMI) 
Playlist for demonstrating Auto Low-latency Mode (ALLM) capability of a DUT monitor.  

Video: 

The Scenarios use a series of images: allm_on_off_000.jpg to allm_on_off_0011.jpg. Text 

panel on the images indicate if ALLM is enabled or not. The first scenario is presented with 

ALLM enabled and the second by switching ALLM on and off sequentially. 

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

ALLM Static 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin 

ALLM Toggle 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_006.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_007.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_008.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_009.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0010.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0011.jpg, Packet: allm_1.bin 
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Playlist: HDR10+ SSTM & SBTM Example (HDMI) 

Description of Scenarios 

Playlist demonstrates using HDR10+ SSTM VSIF for Source-Side Tone Mapping, and HDMI 

Forum SBTM VSIF for Source-Based Tone Mapping. 

  

 Name Duration Repeated sequence 

1 SDR 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel1.jpg, repeated 180 times 

Packets: Infoframes_0005.bin, 

Audio: No audio 

2 HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0005.bin, _0006.bin 

Audio: No audio 

3 SBTM G-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times, Packets: 

Infoframes_0000.bin, _0005.bin, _0007.bin 

Audio: No audio 

4 SDR – SBTM G-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video:  

Step1: Channel1.jpg, repeated 150 times, Packets: 

Infoframes_0005.bin 

Step2: Channel0.jpg, repeated 180 times, Packets: 

0000.bin, _0005.bin, _0007.bin 

 

Audio: No audio 

5 SBTM D-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0005.bin, _0008.bin 

Audio: No audio 

6 SDR – SBTM D-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: 

Step1: Channel1.jpg, repeated 150 times, Packets: 

Infoframes_0005.bin 

Step2: Channel0.jpg, repeated 150 times, Packets: 

0000.bin, _0005.bin, _0008.bin 

 

Audio: No audio 
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Video 

Channel0.jpg 

 

Channel1.jpg 
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Playlist: HDR10+ SSTM Example (DP) 
Playlist demonstrates using HDR10+ SSTM VSIF for Source-Side Tone Mapping. 

 Name Duration Repeated sequence 

1 HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0003.bin 

Audio: No audio 

2 SDR – HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video:  

Step1: Channel0.jpg, repeated 150 times 

Packets: Infoframes_0000.bin, _0003.bin 

Step2: Channel1.jpg, repeated 150 times 

Packets: None 

 

Audio: No audio 

 

Video 

Channel0.jpg 

 

Channel1.jpg 
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Playlist: Frame Rate Example (DP) 
Playlist for demonstrating use of multiple frame rates with FHD and UHD resolution when using 

DisplayPort output.  

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating 

items. The test uses a sequence of images creating a full rotation in 60 frames 

Executed Scenarios 

The test is using four scenarios (RGB 8 BPC, No audio) 

 Name Duration Repeated sequence 

1 Spinners FHD 59fps 60 s 
1920×1080 59.94/60 Hz video timing (VIC 16), 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

2 Spinners FHD 119fps 60 s 
1920×1080 119.88/120 Hz video timing (VIC 63),  

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

3 Spinners UHD 59fps 60 s 
3840×2160 59.94/60 Hz video timing (VIC 97) 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

4 Spinners UHD 119fps 60 s 
3840×2160 119.88/120 Hz Hz video timing (VIC 120) 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 
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Playlist: PSR1 (DP) 
Playlist for demonstrating Panel Replay functionality.  

Video: 

The Scenarios use color_bars_0.jpg image. 

 

Scenarios 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 bpc, No audio. 

Name Duration Repeated sequence 

PSR1 Entry N 10 sec 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin on line 0; 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0001.bin on line 1; 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0003.bin on line 15; 

PSR1 Entry N p 1 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 

PSR1 Abort N p 1 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 

PSR1 Abort N p 2 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 
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